
Adobe®

Dreamweaver®

CC (2017): Part 2

STUDENT MANUAL

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



Adobe®

Dreamweaver®

CC (2017): Part 2

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



Adobe® Dreamweaver® CC (2017): Part
2
Part Number: 092006
Course Edition: 2.0

Acknowledgements
PROJECT TEAM

Author Media Designer Content Editor

Gail Sandler Brian Sullivan Catherine M. Albano

Notices
DISCLAIMER
While Logical Operations, Inc. takes care to ensure the accuracy and quality of these materials, we cannot guarantee their
accuracy, and all materials are provided without any warranty whatsoever, including, but not limited to, the implied warranties of
merchantability or fitness for a particular purpose. The name used in the data files for this course is that of a fictitious company. Any
resemblance to current or future companies is purely coincidental. We do not believe we have used anyone's name in creating this
course, but if we have, please notify us and we will change the name in the next revision of the course. Logical Operations is an
independent provider of integrated training solutions for individuals, businesses, educational institutions, and government agencies.
The use of screenshots, photographs of another entity's products, or another entity's product name or service in this book is for
editorial purposes only. No such use should be construed to imply sponsorship or endorsement of the book by nor any affiliation of
such entity with Logical Operations. This courseware may contain links to sites on the Internet that are owned and operated by third
parties (the "External Sites"). Logical Operations is not responsible for the availability of, or the content located on or through, any
External Site. Please contact Logical Operations if you have any concerns regarding such links or External Sites.

TRADEMARK NOTICES
Logical Operations and the Logical Operations logo are trademarks of Logical Operations, Inc. and its affiliates.
Adobe® and Dreamweaver® are registered trademarks of Adobe Systems Inc. in the U.S. and other countries. The other products
and services discussed or described may be trademarks or registered trademarks of Adobe Systems Inc. All other product and
service names used may be common law or registered trademarks of their respective proprietors.
Copyright © 2017 Logical Operations, Inc. All rights reserved. Screenshots used for illustrative purposes are the property of the
software proprietor. This publication, or any part thereof, may not be reproduced or transmitted in any form or by any means,
electronic or mechanical, including photocopying, recording, storage in an information retrieval system, or otherwise, without
express written permission of Logical Operations, 3535 Winton Place, Rochester, NY 14623, 1-800-456-4677 in the United States
and Canada, 1-585-350-7000 in all other countries. Logical Operations’ World Wide Web site is located at
www.logicaloperations.com.
This book conveys no rights in the software or other products about which it was written; all use or licensing of such software or
other products is the responsibility of the user according to terms and conditions of the owner. Do not make illegal copies of books
or software. If you believe that this book, related materials, or any other Logical Operations materials are being reproduced or
transmitted without permission, please call 1-800-456-4677 in the United States and Canada, 1-585-350-7000 in all other countries.

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



Adobe® Dreamweaver®
CC (2017): Part 2

Lesson 1: Design Considerations.................................... 1
Topic A: Fundamental Design Principles......................................... 2
Topic B: Usability and Accessibility................................................. 7

Lesson 2: Writing for Mobile Platforms..........................11
Topic A: Create Media Queries for Mobile Platforms..................... 12
Topic B: Create Mobile Responsive Pages with Bootstrap.............. 28
Topic C: Modify a Bootstrap Page................................................. 34

Lesson 3: Creating Forms............................................. 53
Topic A: Create a Form with Form Fields.......................................54
Topic B: Validate a Form...............................................................62

Lesson 4: Creating Movement.......................................69
Topic A: Apply CSS Transitions to Create Movement.....................70
Topic B: Apply Behaviors to Create Movement.............................. 76

Lesson 5: Adding Multimedia........................................83
Topic A: Insert Audio Files............................................................84

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



Topic B: Insert Video Files...................................................................... 87

Lesson 6: Marketing Through Social Media and Email........... 91
Topic A: Plan a Social Media Strategy......................................................92
Topic B: Add Links to Social Media......................................................... 97
Topic C: Create Email Marketing Materials and Newsletters.................. 101

Lesson 7: Testing and Maintaining Your Site.......................115
Topic A: Validate Your Site Against W3 Standards.................................116
Topic B: Share Website Files with Other Users.......................................121
Topic C: Synchronize Your Site............................................................. 132

Lesson 8: Setting Project Requirements.............................. 137
Topic A: Identify Purpose, Audience, Audience Needs...........................138
Topic B: Adhere to Copyright Rules for Site Content............................. 144
Topic C: Determine and Evaluate Project Management Tasks and

Responsibilities................................................................................ 147

Mastery Builders................................................................................. 155
Solutions............................................................................................ 163
Glossary............................................................................................. 169
Index..................................................................................................171

|  Adobe® Dreamweaver® CC (2017): Part 2  |

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



About This Course

You are familiar with creating web pages and now you will use Adobe® Dreamweaver® CC
(2017) to enhance web pages by adding advanced functions such as movement, media
elements, forms, and links to social media. You will also create responsive pages to ensure
that your websites are compatible with various modern display devices, such as tablets and
smartphones. You will create HTML email for email marketing or email newsletters. Lastly,
you will share files over a server to work in a collaborative manner. All this will ensure that
you develop a website that retains user interest by providing an engaging user experience
across multiple display devices.
This course is a great component of your preparation for the Adobe Certified Expert (ACE)
Dreamweaver CC exam and the Adobe Certified Associate (ACA) Web Authoring Using
Adobe Dreamweaver CC exam. See the files in the Exam Mapping for Dreamweaver CC
folder in the course data files for information on how the exam topics are addressed in the
material.

Course Description
Target Student
This course is designed for those who have some experience using Dreamweaver to design
or modify websites and want to learn more. Students may be designing sites for the Internet
or sites for their company’s intranet. Students may be creating new sites or redesigning or
updating existing sites. Students may be creating HTML email or newsletters. Web design
may be only one part of the students’ job duties. Or perhaps web design is the student’s
primary job function. Students may be artists or developers who wish to use a WYSIWIG
tool for speed and ease of use.

Course Prerequisites
To ensure your success, you should have:
• Basic Windows skills.
• Basic knowledge of HTML5 and CSS. You can obtain this level of skills and knowledge

by taking the Logical Operations course HTML5: Content Authoring Fundamentals.
• Basic knowledge of Dreamweaver, including how to create a page and site, and add and

style text, images, links, and tables in Dreamweaver. You can obtain this level of skills
and knowledge by taking the Logical Operations course Adobe® Dreamweaver® CC (2017):
Part 1.

Course Objectives
In this course, you will be able to develop interactive and engaging websites that are
compatible with multiple display devices.
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You will:
• Implement basic design principles in writing a website.
• Author a site suitable for both mobile and desktop viewing.
• Create forms.
• Add movement through behaviors and CSS transitions.
• Insert audio and video media.
• Reach your target audience through social media and HTML email marketing.
• Manage website files through testing and synchronizing.
• Set project requirements.

The CHOICE Home Screen
Logon and access information for your CHOICE environment will be provided with your class
experience. The CHOICE platform is your entry point to the CHOICE learning experience, of
which this course manual is only one part.
On the CHOICE Home screen, you can access the CHOICE Course screens for your specific
courses. Visit the CHOICE Course screen both during and after class to make use of the world of
support and instructional resources that make up the CHOICE experience.
Each CHOICE Course screen will give you access to the following resources:
• Classroom: A link to your training provider's classroom environment.
• eBook: An interactive electronic version of the printed book for your course.
• Files: Any course files available to download.
• Checklists: Step-by-step procedures and general guidelines you can use as a reference during

and after class.
• LearnTOs: Brief animated videos that enhance and extend the classroom learning experience.
• Assessment: A course assessment for your self-assessment of the course content.
• Social media resources that enable you to collaborate with others in the learning community

using professional communications sites such as LinkedIn or microblogging tools such as
Twitter.

Depending on the nature of your course and the components chosen by your learning provider, the
CHOICE Course screen may also include access to elements such as:
• LogicalLABS, a virtual technical environment for your course.
• Various partner resources related to the courseware.
• Related certifications or credentials.
• A link to your training provider's website.
• Notices from the CHOICE administrator.
• Newsletters and other communications from your learning provider.
• Mentoring services.
Visit your CHOICE Home screen often to connect, communicate, and extend your learning
experience!

How to Use This Book
As You Learn
This book is divided into lessons and topics, covering a subject or a set of related subjects. In most
cases, lessons are arranged in order of increasing proficiency.
The results-oriented topics include relevant and supporting information you need to master the
content. Each topic has various types of activities designed to enable you to solidify your
understanding of the informational material presented in the course. Information is provided for
reference and reflection to facilitate understanding and practice.
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Data files for various activities as well as other supporting files for the course are available by
download from the CHOICE Course screen. In addition to sample data for the course exercises, the
course files may contain media components to enhance your learning and additional reference
materials for use both during and after the course.
Checklists of procedures and guidelines can be used during class and as after-class references when
you're back on the job and need to refresh your understanding.
At the back of the book, you will find a glossary of the definitions of the terms and concepts used
throughout the course. You will also find an index to assist in locating information within the
instructional components of the book.

As You Review
Any method of instruction is only as effective as the time and effort you, the student, are willing to
invest in it. In addition, some of the information that you learn in class may not be important to you
immediately, but it may become important later. For this reason, we encourage you to spend some
time reviewing the content of the course after your time in the classroom.

As a Reference
The organization and layout of this book make it an easy-to-use resource for future reference.
Taking advantage of the glossary, index, and table of contents, you can use this book as a first
source of definitions, background information, and summaries.

Course Icons
Watch throughout the material for the following visual cues.

Icon Description

A Note provides additional information, guidance, or hints about a topic or task.

A Caution note makes you aware of places where you need to be particularly careful
with your actions, settings, or decisions so that you can be sure to get the desired
results of an activity or task.

LearnTO notes show you where an associated LearnTO is particularly relevant to
the content. Access LearnTOs from your CHOICE Course screen.

Checklists provide job aids you can use after class as a reference to perform skills
back on the job. Access checklists from your CHOICE Course screen.

Social notes remind you to check your CHOICE Course screen for opportunities to
interact with the CHOICE community using social media.
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Design Considerations
Lesson Time: 30 minutes

Lesson Introduction
You are familiar with the fundamentals of creating web pages in Adobe® Dreamweaver®

CC. With millions of web pages vying for user attention, the onus is on you, as a web
designer, to present content in a manner that will both attract interested users and ensure
that they will revisit your website. Familiarity with various website design requirements will
help you design a functional website that is user-friendly and accomplishes your website's
objectives. 
Developing a successful website depends on how well you understand the needs of your
end users. This involves identifying your target audience and how they access and use
information on the devices they prefer.

Lesson Objectives
In this lesson, you will:

• Apply fundamental design principles to enhance page and site appearance and
effectiveness.

• Apply principles of usability and accessibility.

1
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TOPIC A
Fundamental Design Principles
In order to ensure that the website accomplishes its goals and objectives, the objectives and target
audience must be clearly defined. If you do not clearly define them, you run the risk of creating a
site that, no matter how attractive, does not accomplish its goals. Create a consistent look between
your pages. This will enhance interest and trust in your organization and therefore in your product,
services, and messages. Judicious use of fonts and colors will also contribute to interest and
credibility. All of these factors should be considered before creating individual pages.

Website Design Considerations
Start with your purpose. Before reviewing any other design considerations, consider your intent in
creating your site. What action do you wish the site visitor to take as a result of viewing your pages?
In web design parlance, this action is called conversion: You have converted the visit into a desired
visitor action. This action could be making a purchase, calling your organization, completing a form
or survey, attending entertainment, learning something new, or changing an attitude. Or it could be
as simple as enjoying your site.
Define your target audience. Consider not just who your current customers/site visitors are, but also
who you would like to add to your customer or viewer base. Who do you want to attract to your
website? What is the age, gender, location, income bracket, and education level of your intended
audience? What are their interests, occupations, and pastimes? How do they use their computer,
tablet, or smartphone?

Figure 1-1: Factors that define the target audience.

Your website will be viewed as an expression of your organization's character and the products or
services you provide. Before you create the design, clarify the image you wish to project. Is your
organization's image whimsical and playful or professional and corporate? Do your products and
services appeal to tradition, or promote a forward-looking outlook? Coordinate with your marketing
department and other stakeholders. If you are designing a site for another organization, get a clear
sense of the tone they wish to set before you begin.
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Once you have defined the website purpose, target audience, and tone, then design the look and feel
of the site. Website colors, graphics, and fonts should be consistent with print advertising or
brochures, and consistent with other media you use to reach your intended audience. Use your logo.
Not only should the look of your site be consistent with other materials, but it should also be
consistent internally. In other words, use the same colors, fonts, look, and feel on each page. To
some extent, use a similar layout on each page and similar navigation.

Colors, Fonts, and Layout
When drawing together the web design team, include a graphic artist. If you are not a graphic artist
and don’t have one on staff, consider hiring one. The colors, fonts, and layout of your pages
represent your organization and its products to the world as much as the text. If you cannot hire a
graphic artist, here are a few principles to start with.
Although it is possible to create attractive, engaging designs with one color or many colors, try
starting with only a few. Adobe provides a tool for creating color schemes, Adobe's Kuler color
wheel, available at https://color.adobe.com. Another popular tool for creating color schemes is
available at www.paletton.com.
This same principle of "less is more" can be applied to fonts. Too many fonts can be distracting,
make your pages hard to read, and detract from a professional appearance. Select one font for your
headings and one for the body text. Ensure that the font size is large enough to read, given the age
of your target audience. Text color should contrast with background color. If the background is
light, use a dark text color. If the background is dark, use a light text color. Dark text on a light
background is easier to read. Avoid overly ornate fonts, as they can be difficult to read.

Periodic Updates
To maintain trust in your site and organization, and to keep visitors coming back, ensure that the
information on your site is updated regularly. Accurate up-to-date information protects and
enhances your credibility. New information keeps viewers coming back. In addition to updating
information, periodically update the look and feel of your site. You might consider the web as
following fashion trends, just as clothing, cars, and home decor follow such trends. Has it been
several years since you changed the site's appearance? Does your site look a few years behind current
styles on the web? If you answered yes to these questions, consider redesigning your site.

The Benefits of Consistency
Several aspects of design should be consistent across the pages of a site, such as:
• Fonts
• Colors
• Navigation
• Locations for navigation, search, and login
• Image styles
Consistency offers several benefits. Consistency:
• Enables users to view and navigate the site easily.
• Reinforces in the user's mind that he is still viewing the same site.
• Reinforces recognition of your brand.
• Provides a more professional look.
• Allows design of templates that can be applied across web pages in a website. This will make the

designing, publishing, and maintenance of a website easier.
• Enables presentation of content in an organized and structured way with the implementation of

eXtensible Markup Language (XML) and Cascading Style Sheets (CSS).

Adobe® Dreamweaver® CC (2017): Part 2  |  3
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Note: To learn more about image styles in Dreamweaver, check out the LearnTO Work with
Dreamweaver Image Options presentation by clicking the LearnTO tile on your CHOICE
Course screen.

Guidelines for Website Design Considerations
Note: All of the Guidelines for this lesson are available as checklists from the Checklist tile on
the CHOICE Course screen.

Much has been said and written about planning a website. Here are a few selected key principles to
follow.
• Put the purpose first. Define the website goal and objectives. What should the user do upon or

after visiting the site? Make a purchase? Complete a survey? Learn something new? Change an
attitude?

• Define your target audience.
• Create a look and feel that is consistent with your brand.
• Create consistency of look and feel between the pages: Use the same colors and fonts and place

key components such as search and navigation in the same location on each page.
• Limit the number of fonts to two or three.
• Limit the number of colors.
• Express the character of your organization, products, services, and message.
• Update the look and feel of your site periodically. Styles change on the web. An outdated look

can damage site credibility and will not encourage visitors to return.
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You may want to show
LearnTO Work with
Dreamweaver Image
Options from the
CHOICE Course screen
or have students
navigate out to the
Course screen and
watch it themselves as a
supplement to your
instruction. If not, please
remind students to visit
the LearnTOs for this
course on their CHOICE
Course screen after
class for supplemental
information and
additional resources.
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ACTIVITY 1-1
Examining Website Design Considerations

Scenario
You are part of a team which will design a website for Emerald Epicure, an online source of olives
and olive oil targeting the home gourmet chef as well as smaller restaurants. As part of its efforts to
increase sales, Emerald Epicure's marketing department aims to raise awareness of its products'
health benefits, many recipe options, and the wide selection of quality olives. (You will work on
pages for Emerald Epicure's site throughout this course.) As a first step, use your knowledge of
website design to answer the following questions.

1. Which of the following are design considerations that you will need to think about before starting your
website design? (Choose two.)
☐  Target audience
☐  Purpose of a website
☐  Software application
☐  Web page navigation

2. Which of the following audience characteristics should you evaluate while designing a website?
(Choose four.)
☐  Age
☐  Ethnicity
☐  Educational qualification
☐  Income
☐  Level of computer literacy
☐  Marital status

Adobe® Dreamweaver® CC (2017): Part 2  |  5
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You may wish to have
students work in pairs to
enhance engagement. If
two or more remote
students are located at
the same site, ask them
to work together. If the
remote students are not
located together and
your conferencing tool
supports private chats,
consider having them
use private chat to work
together.
Problem Design 1
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3. Observe the screen capture of a web page. What design flaws do you see?
 

 
A: Discuss the following possible answers: There are too many fonts. The font used for the sentence

"If green olives are required they are harvested earlier" is difficult to read. There is insufficient
contrast between the font color and the background color. Students might also note that the image
of the harvest tool has padding, while the image of the olives does not, and that the arrangement
and spacing of the text and two pictures is unattractive.

4. Sylvia has been assigned the task of developing a website for a client, Emerald Epicure, within a week.
Because the client wants the site to be up and running soon, Sylvia immediately begins designing the
site and soon proceeds to developing the layout and then the coding for the site. In your opinion, is
Sylvia’s decision to immediately get started with designing the website appropriate?
A: Answers may vary, but can include: Skipping tasks such as identifying the website purpose and

analyzing the target audience may result in developing a website that fails to meet its intended
purpose. This can result in rework and delays in meeting scheduled commitments.
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TOPIC B
Usability and Accessibility
Usability is the ease and effectiveness with which your target audience can use the site. Accessibility
is how well the site enables visitors with vision, hearing, and motor challenges to use the site.
You have examined selected key website design considerations. Several of these, such as choosing
readable fonts and ensuring adequate contrast between the font color and background color, are
also crucial to usability. You will examine additional principles of usability and accessibility. Near the
end of the course, after you have created mobile-ready pages, forms, and movement, and inserted
multimedia, you will revisit the issue of usability and explore usability testing.

Best Practices for Usability
Usability is the extent to which users can find and absorb relevant content, access the site’s functions,
and feel satisfied with the process of doing so. Factors that make a site more or less usable have
been widely studied, including studies that track eye movement as users view web pages. A great
deal has been written on the subject.
You have already encountered some usability principles in the previous topic, such as choosing
simple, readable fonts and ensuring adequate contrast between text and background color. The
following are selected principles.

Layout and Navigation
• Reserve particular locations for page elements such as navigation, search, login, and content. For

example, a user who uses the Search option at the top-right corner on one page will have
problems if it is moved to a different location on other pages of the website.

• Make navigation obvious.
• Link text should use words your users already know.
• Don’t make users recall what has come before in order to navigate.
• Be cautious about using icons for navigation: be sure they are self-explanatory.
• Links should look like links. Users should not have to wonder which text is link text.

• Use white space. White space makes it easier for viewers to divide the page content into
segments and thus comfortably find what they need.

• Your viewers have viewed many other sites, and certain layouts and navigation choices have
become common. Thus, it is easier for viewers to use your site if your site’s layout and navigation
is similar to common patterns on the web.

Text and Colors
• Avoid small fonts. This makes reading easier for everyone, not just the visually impaired.
• Text with extra letter spacing and extra line spacing is easier to read.
• Always set a background color, even if that background color is white. Browsers allow users to

change their default background color. If you do not set a background color, the user’s default
background color may not provide sufficient contrast to your text color.

Content
• Include relevant content only.
• Omit unneeded words.
• Provide a title for each page.
• Users tend to scan web pages instead of reading the entire page. This scanning is not done in a

linear fashion. Because viewers read web pages differently from printed pages, writing for the

Adobe® Dreamweaver® CC (2017): Part 2  |  7
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Usability: Navigation,
Fonts, Colors
Ask students to describe
sites they found
frustrating to visit, and
what aspects of the sites
caused their frustration.

Usability: Content
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web is different from writing for print. Help users find the most relevant information quickly
with the following techniques:
• Avoid long blocks of text.
• Use short phrases. Be concise.
• Use headings.
• Use bulleted or numbered lists for easy reading.
• Format keywords as bold or italic.
• Break up text with images.

• Use common terms. Avoid technical jargon unless your target audience is familiar with it.
• Images catch the eye and often can convey information more quickly than text.

Personal Information and Logins
• If you want users to make a purchase or use a feature, provide the product information or let

them try out the feature before asking for personal information such as their email address.
• Require user registration only if it serves a purpose. Registration reduces traffic. That said,

registration may serve a legitimate marketing or security purpose.
If you follow these principles, viewers will be more apt to find what they want, feel comfortable on
your site, convert their visit to action, and make return visits.

Best Practices for Accessibility
Accessibility techniques can ensure that those with vision, hearing, and motor challenges can use
your site. As our population ages, a growing proportion of the public will develop challenges that
make it hard to use sites that do not implement these techniques. Some of the common accessibility
techniques include:
• Use alternative text on images and image maps so that visually impaired people who use screen

readers can read the text specified for the image.
• Design web pages in such a way that all information conveyed by using color is also available

without color.
• Highlight and identify the row and column headers for data tables.
• Provide captions for tables.
• Provide text equivalents for buttons and image navigation.
• Provide an easy navigation scheme.
• Provide skip buttons or links to skip to main content links and navigation links.
• Provide redundant text links for each active region and label the links with commonly used

terms.
• Provide a label for every form input field so that screen readers can inform the visually

handicapped about the field.
• Provide captions for videos or a transcript.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Strengthen Accessibility.
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ACTIVITY 1-2
Designing Usable and Accessible Sites

Scenario
A colleague has drafted a home page for Emerald Epicure. You have been asked to assess the page
for usability and accessibility.

1. Observe the following draft home page and suggest modifications to enhance usability.
A: Answers will vary and may include: Enlarge the text, add white space, break up the text with

headers, add bulleted lists, and format keywords as bold or italic.
 

 

2. Re-examine the image above and suggest ways to enhance accessibility.
A: Answers will vary and might overlap with answers in the previous question. Answers might

include: The table header row should be highlighted and font size should be larger.

3. Examine the following code for the images of olives and urns in the screen shot above. How could the
code be modified to enhance accessibility?
A: Images should have descriptive alt text.
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Problem Design 2
This is a very brief
exercise. You might use
the exercise as the
starting point for your
discussion of usability
and accessibility. Break
the group into pairs or
small groups.
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Summary
In this lesson, you have examined fundamental website design considerations. You have analyzed a
page for both usability and accessibility.

Are there aspects of your existing website that you could change to enhance usability? If your website is in
early planning stages, what do you plan to do to enhance usability?

A: Answers will vary. Students may know of aspects of their site that could use improvement, or they may
be early in the planning process.

Who is the target audience for your website? What do you know about them and what implications does
this knowledge have for your website design?

A: Answers will vary. Knowledge of the target audience could affect choices about tone, layout, colors,
vocabulary, complexity, and more.

Note: Check your CHOICE Course screen for opportunities to interact with your classmates,
peers, and the larger CHOICE online community about the topics covered in this course or
other topics you are interested in. From the Course screen you can also access available
resources for a more continuous learning experience.
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for further discussion
and resources to support
continued learning.
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Writing for Mobile
Platforms
Lesson Time: 2 hours, 30 minutes

Lesson Introduction
You have examined and applied design principles that can make your site more attractive
and impressive. One of the most challenging tasks in authoring websites is planning and
creating pages that work well on multiple devices with differing screen sizes and resolutions.
Dreamweaver CC offers several tools for using today's methods for achieving these goals.

Lesson Objectives
In this lesson, you will:

• Create and test pages that change with window size (responsive pages).

• Create responsive pages quickly with Bootstrap.

• Modify a Bootstrap page.

2
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TOPIC A
Create Media Queries for Mobile Platforms
In order to author pages that are effective and attractive across multiple devices, you will need to
consider small-screen design factors, view pages in varied sizes, and use methods and tools for
modifying the layout and even the content.

Tools for Mobile Design
You will examine how to create a design with small screens in mind. Dreamweaver offers several
tools for implementing your design:
• Two quick methods for viewing your page in varied sizes
• The Visual Media Query bar to help with layout and content changes
• Time savers for writing CSS for multiple screens and even print output
• Bootstrap, a popular framework for speeding up the process
You will work with all of these methods in this lesson. You will start with a look at how to plan a
usable mobile design.

Figure 2-1: Visual Media Query bar.

The Challenge of Writing for Mobile Devices
As adults increasingly rely on smart phones and tablets, many actually do more of their Internet
browsing on mobile devices than on their desktop computers. So you can safely assume that a
significant number of viewers will try to access your content from mobile devices. We've all visited
sites that worked well on these smaller screens, and we've seen sites that did not. In designing for
mobile devices, consider the following:
• Readable font size and weight
• Readable images
• Download speed
• Links large enough to be clicked by touch
• Navigation structure that is both easy to understand and minimizes unnecessary intervening

pages. Navigation for smaller screens needs to be simpler.
• Forms that allow completion by touch
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Tools for Mobile Devices
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be time consuming and
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the Dreamweaver tools
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to access websites and,
in doing so, visited sites
that were hard to read or
navigate. Ask students
what made the sites
difficult to use.
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In general, you can solve the challenge of multiple screen sizes in one of two ways. One method is
to design two or three separate websites from the ground up for varied devices. Or you can use
responsive web design, which is to say you can use your HTML and CSS to resize, move, hide, or resize
the content for various devices.
The @media CSS rule allows you to apply CSS styles to adjust your content for screen sizes you
specify. Whichever method you choose, consider the factors listed previously.
In discussing the window size of various devices, web designers and developers often talk about the
viewport, which is the user's visible area of a web page. Use a meta viewport element to set the
viewport to the width of the device.

Figure 2-2: Viewport Meta tag.

Guidelines for Writing for Smartphones and Tablets
Note: All of the Guidelines for this lesson are available as checklists from the Checklist tile on
the CHOICE Course screen.

Follow these guidelines to ensure that your websites can be easily viewed and navigated on mobile
devices:
• Each web page should detect the device used and its screen size.
• Links and buttons should be at least 30 pixels wide or tall.
• Avoid horizontal scrolling.
• Don't overdo the number of images, as too many images will slow download speed.
• Use small images that users can tap to zoom. Provide clear instructions on how to zoom in and

how to move between images.
• Your content will be far narrower than it would be on a desktop and, therefore, it will "wrap."

Plan visually pleasing wrapping.
• Consider download speed of the entire page.
• Size form fields for usability. You will explore this later in the "Creating Forms" lesson.
• Keep navigation simple, with as few taps as possible. Remember that each additional page load

means increased wait time and, for those without unlimited data plans, the possibility of
increased costs.

• Keep menus short. Where the goal of fewer taps conflicts with the goal of short menus, strive
for a workable balance.

• Breadcrumbs can help users identity the section they came from.
• Tapping the organization logo should return the user to the home page because that's what users

expect.
• Avoid submenus that require hovering. Consider drop-down accordion menus instead, with

perhaps a sandwich navigation icon, sometimes called the hamburger icon, at the top left or
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stay abreast of current
sizes so that you can
discuss these with
students.
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right, to display the menu. Accordion menus allow the user to tap a main menu item to view the
submenu items vertically.

Figure 2-3: Sandwich or hamburger icon.
• Offer a visible search box at the top of the page.
• For complex interactions such as making a purchase or completing a form or survey, make it

easy for the visitor to email a link to themselves or save-to-cart so that they can complete the
interaction on a desktop, or perhaps after browsing on a smartphone, complete a form or
purchase on a tablet.
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ACTIVITY 2-1
Evaluating a Page for Mobile Readiness

Data Files
All files in C:\092006Data\Writing_for_Mobile_Platforms\Topic_A\starter

Before You Begin
Dreamweaver is open.

Scenario
The Emerald Epicure notices that a growing number of their website viewers are using phones and
tablets to view their website. Several website viewers have expressed frustration in reading pages,
finding information, and following links. The company's website analytics display a steady stream of
visitors to the home page, but a downward trend in visitors who follow links from the home page to
other site pages. The company decides to conduct an analysis of site usability on mobile devices.

Note: Activities may vary slightly if the software vendor has issued digital updates. Your
instructor will notify you of any changes.

1. Create a new site for the company Emerald Epicure.
a) In the Files panel, from the Site drop-down list, select Manage Sites.
b) Select New Site.
c) In the Site Name text box, enter Emerald Epicure
d) To the right of the Local Site Folder text box, select the folder button and browse to C:\092006Data

\Writing_for_Mobile_Platforms\Topic_A\starter.
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reminder to update
Dreamweaver, ignore it.
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would also need to be
redefined, and thus
tends to inconvenience
and possibly confuse
students.
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e) Select Select Folder.
 

 
f) In the Site Setup dialog box, select Save.
g) In the Manage Sites dialog box, select Done.
h) In the Files panel, observe the file list. A home page and accompanying images were included in the

root folder.

2. Open a file and resize window in a fluid manner.
a) In the Files panel, Open index.html.
b) Change the view for the document window to Live view.
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As students resize the
viewport, ask them their
opinion of how easy it is
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problem with navigation
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suggestions for
improving the sample file
so that it would display
better on smart phones
and tablets.
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c) Drag the scrubber toward the left. Observe the change in window size as you drag the scrubber to
various positions.
 

 

3. Resize the window using the Window Size selector.
a) At the far right of the status bar, select the Window Size selector.

 

 
b) Select the iPad view. Note whether text is readable and navigation is easy to use in the iPad view.
c) Select the iPhone 7 view.

Note: Note whether text is readable and navigation is easy to use in the
iPhone 7 view. Observe the position of the three side-by-side images.

d) Use the Window Size drop-down list to switch to Orientation Landscape. Observe how the layout
adapts. Note whether there is any aspect of the layout that does not work.
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View the page in the
iPone6 setting and ask
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the three side-by-side
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e) To return the window to full size, double-click the area labeled "Double click to fit width." The window
expands to the width and height of your document window.

4. Create a custom window size.
a) Select the Window Size drop-down list in the right corner of the status bar.
b) Select Edit Sizes.

The Window Sizes category is selected at the left of the Preferences dialog box.
 

 
c) Select the plus sign ( + ) at the lower-left of the list of sizes.

A text box appears just below the last width entry.
d) In the Width column text box, type 470
e) Press Tab. A text box appears just below the last height entry. In the Height text box, type 310
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Stay up to date on new
devices and sizes. You
may wish to substitute a
new size for the size
used in this example.

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



f) Press Tab. In the Description text box, type My Example Android Phone
 

 
g) Select Apply.
h) In the Preferences dialog box, select Close.
i) To view the page in your new window size, select the Window Size drop-down list, and select My

Example Android Phone.
j) To return the window to full size, double-click the "Double click to fit width" area. The window

expands to the width and height of your document window.

Media Queries
A media query is CSS code that uses the @media CSS rule to apply a set of CSS properties only for
devices with certain capabilities, such as a specified width, orientation, or resolution. Dreamweaver
empowers you by providing the Visual Media Query bar and CSS Designer panel so you can create
media queries without writing code by hand.

Figure 2-4: The Visual Media Query bar.

Use the Visual Media Query bar to define several possible viewport widths. You may define the
minimum width or maximum width or both.
Then use CSS Designer to associate each size definition with CSS rules that control formatting and
layout.
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The Visual Media Query bar sits at the top of the document window. Colored bands in the bar make
it easy to resize the window to each media query, affording a preview of your page in viewports of
various sizes.
• A green band denotes a query that defines a maximum width but not a minimum width.

Viewports narrower than this maximum width would use the styles associated with this media
query.

• A purple band denotes a query that defines a minimum width but not a maximum width.
Viewports wider than this minimum would use styles associated with this media query.

• A blue band denotes a query that defines both a minimum width and a maximum width.
Viewports with widths between the maximum and minimum widths would use the styles
associated with this media query.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Create a Media Query.
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ACTIVITY 2-2
Creating a Media Query

Data Files
All files in C:\092006Data\Writing_for_Mobile_Platforms\Topic_A\starter

Before You Begin
The C:\092006Data\Writing_for_Mobile_Platforms\Topic_A\starter\index.html file is
open.

Scenario
You have been assigned the task of making the Emerald Epicure home page attractive and usable on
devices of various sizes. You decide to write media queries to facilitate this process.

1. Add the viewport Meta tag.

Note: There is no need to select a location in the document window.
Dreamweaver will place the meta tag in the head.

a) In the Insert panel, select the HTML category.
b) Select Meta.

 

 
c) In the Value text box, type viewport
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d) In the Content text box, type: width=device-width, initial-scale=1.0
 

 
e) Select OK.
f) Switch to Split view.
g) Scroll to the head section to observe the meta tag.

 

 
h) Select Live view.

2. Delete image widths in pixels.
a) If the Property Inspector is not already displayed, select Window→Properties to display it.
b) If the Property Inspector is not docked at the bottom of the screen, drag the Property Inspector panel

below the Tag Selector to dock it.
c) Select the Emerald Epicure logo.
d) In the Properties Inspector, delete the width and height.
e) Select the banner3.png; that is, the image containing the bottle of salad dressing.
f) In the Properties Inspector, delete the width and height.
g) Observe that the width and height have already been deleted for the remaining images.

3. If it is open, close the DOM panel to allow more room to observe CSS Designer.
a) Select the DOM panel menu.
b) Select Close Tab Group.

4. Set the image widths in percentages.
a) Widen the CSS Designer panel until Sources displays on the left and Properties displays on the

right.
b) At the top of the CSS Designer panel, if All is not yet selected, select it.
c) Under Selectors, select #logo.
d) In the CSS Designer Properties, set the width to 100%
e) In the document window, select the banner image.
f) Under Sources, select styles.css.

g) In the Selectors panel, select  and delete all of the text except #banner_image.
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h) Press Enter.
i) In the Properties panel, set the width to 100%

5. Create a media query for viewports with a maximum width of 768px.
a) In Live view, drag the scrubber to 768px on the ruler.

A plus sign ( + ) appears on the ruler.
b) Select the plus sign ( + ) on the ruler to set the width of the media query. You have created a

breakpoint.
The ruler now displays green to the left of the breakpoint. A pop-up box appears.
 

 
c) Observe that the drop-down list at the top of the pop-up box is set to max-width.
d) Still in the pop-up box, verify that max-width is set to 768
e) From the drop-down list which initially displays Create a New CSS File, select styles.css to add the

media rule to the styles.css file.
f) Select OK.

The Visual Media Query bar now displays a green bar to the left of the 768px point.
 

 
g) Switch to Split view and above the Document window, select styles.css.
h) Scroll down to the bottom of the file and observe the media rule.

 

 

6. Create a media query for viewports between 768px and 991px.
a) Switch to Live View.
b) Note: If 990 is not visible on the ruler, collapse the panels at the right of your

screen.

Drag the scrubber to 990px on the ruler.
A plus sign appears on the ruler.

c) Select the plus sign ( + ) on the ruler to set the width of the media query. You have created another
breakpoint.

d) Set the drop-down list at the top of the pop-up box to min-max.
e) Still in the pop-up box, in the min-width text box, enter 768
f) Still in the pop-up box, in the max-width text box, enter 990
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g) Verify that the drop-down list nearest the bottom of the box displays styles.css to add the media rule
to the styles.css file.
 

 
h) Select OK.

The Visual Media Query bar now displays a blue bar between the 768px and 990px points.
 

 
i) Switch to Split view and verify styles.css is displayed. Observe the updated media rule.

 

 
j) Select File→Save All.

Varied Styles for Varied Viewports
CSS Designer allows you to create CSS rules for each media query without writing code. In the
@media section of CSS Designer, select the media query you wish to edit. Then, just as you would
for a non-responsive page, in the Selectors section of CSS Designer, select any selector. In the
Properties section, edit the properties of the selector.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Create Styles for Media Queries by Using CSS Designer.
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ACTIVITY 2-3
Adding Styles to a Media Query

Data Files
All files in C:\092006Data\Writing_for_Mobile_Platforms\Topic_A\starter

Before You Begin
The C:\092006Data\Writing_for_Mobile_Platforms\Topic_A\starter\index.html file is
open.

Scenario
Now that you have created two media queries, you are ready to modify the styles of page elements
when viewed in a small viewport.

1. With index.html open, in the Visual Media Query bar, select the green bar for the media query with a
width of 768px. Observe changes in the page appearance. What would you want to change in this
view?
A: Answers may vary. The Contact us navigation button overlaps the Harvesting button.

2. Style the Navigation buttons to appear below the logo.
a) If your document window is now smaller than 768px, again select the 768 px media query.
b) Make sure the CSS Designer panel is visible. If the Sources panel does not appear to the left of

CSS Properties, widen the panel until it does.
c) Under Sources, select styles.css.
d) Under Selectors, right-click .top-right-nav.

A context menu appears.
e) On the context menu, select Duplicate into media query and, on the submenu that appears, select

(max-width: 768px).
 

 
f) Switch to Split view.
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g) At the bottom of styles.css, observe the new .top-right nav rule within the @Media (max-width:
768px) rule.
 

 

3. Style the navigation buttons to appear below the logo in narrow viewports.
a) Select Live view.
b) In CSS Designer, under @Media, select (max-width:768px).
c) Under Selectors, select .top-right-nav.
d) In the Properties pane, set width to 100%.
e) In the margin box, make sure the lock icon is open. Then select the bottom value, the margin-

bottom, and type 20px
 

 
f) In the Properties pane, change the float value to left and the text-align value to left.
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g) Observe that the navigation buttons now appear below the logo.
 

 

4. Save and close the file.
a) Select File→Save All.
b) Select File→Close.
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TOPIC B
Create Mobile Responsive Pages with Bootstrap
You have examined and used visual mobile queries to assist in creating responsive designs. You have
probably already noticed that creating responsive pages can be truly time-consuming. You will now
explore a tool to speed this process.

Tools for More Efficient Responsive Design
Dreamweaver provides two tools you can use to produce more efficient responsive designs:
• Fluid grid layouts: Dreamweaver 2014 offered a template for fluid grid designs. Dreamweaver

now labels this template as "legacy." Pages written with this template cannot be edited in Design
view.

• Bootstrap: A popular framework that goes beyond a fluid grid layout, saving design time
necessary for responsive pages. Dreamweaver can create Bootstrap pages.

Fluid Grid Layouts
Grid layouts can be used in designing either static or responsive pages. In a grid layout, the page is
divided into columns. Bootstrap pages in Dreamweaver use 12 columns by default. Although a grid
layout can be used as a way to arrange elements on a non-responsive page, it also shines as a way to
adjust the arrangement of page elements for mobile devices. As the viewport size decreases, content
that would be displayed in the rightmost columns on a desktop can be more easily shifted
downward below the left-most columns. Or, put another way, on mobile devices, the right-most
columns can appear as new rows below the left-most columns.
Page layouts can be fixed-width or fluid in nature, and this is true for grid layouts as well. Fixed-
width layouts assume a page that is a defined number of pixels wide, and page elements that are also
a defined number of pixels wide. Fluid layouts define the width of page elements as a percentage of
their containers. A fluid grid layout can define the grid columns as a percentage of the viewport
width.
Fluid grids can be immensely helpful in designing responsive sites. However, a fluid grid layout by
itself does not guarantee an attractive, easy-to-read page in varied viewports. For example, a layout
that is pleasing and usable in a 960-pixel layout may appear stretched, with too much blank space
between elements, when displayed in a larger window. Using only a fluid layout to achieve
responsiveness cannot prevent links and forms that are difficult to use on mobile devices, or text
that is too small or does not adequately contrast with background on small devices.
Older versions of Dreamweaver CC offered a fluid grid template. Although that fluid grid template
still exists in the current version of Dreamweaver CC, it is labeled a legacy document type. Design
view cannot be used with the fluid grid template.

Note: To learn more about fluid layouts, check out the LearnTO Work with Fluid Layouts
presentation by clicking the LearnTO tile on your CHOICE Course screen.

Overview of Bootstrap
As previously noted, further adjustments can be made by using media queries to apply CSS styles.
However, this process can be hugely time consuming. You are, in effect, writing several versions of
each web page. Bootstrap is a popular framework that can save you a great amount of time in
designing responsive pages.
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Bootstrap uses HTML5, CSS templates, and JavaScript plug-ins to provide a responsive grid layout,
plus responsive navigation, text, buttons, forms, tables, images, image carousels, and more. You can
choose fluid or fixed-width containers.
Why use Bootstrap?
• You can create responsive sites faster.
• Bootstrap combines tested pre-built HTML, CSS templates, and JavaScript plug-ins.
• All of the major browsers are compatible with Bootstrap.
• Dreamweaver makes Bootstrap easy. Templates and plug-ins are automatically created when you

create a page. Dreamweaver's graphical interface minimizes manual code writing as you design
and edit your Bootstrap page.

So when might you not want to use Bootstrap?
• When you don’t need responsiveness. Perhaps you are working on intranet pages that are never

viewed on mobile devices.
• When responsive pages already exist and do not need major modification.
• When the time and money required to rewrite a great many pages outweigh projected benefits.
• When your site’s page contributors and editors are not familiar with HTML and CSS. Bootstrap

presupposes a familiarity with HTML and CSS. In this situation, consider a Content
Management System (CMS) that will make contributing easy for those without this knowledge.

Bootstrap Pages
You can create a Bootstrap page in several ways.
• From a template for a specific purpose, including both layout and suggested content.
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Figure 2-5: A page based on Dreamweaver's Bootstrap template "agency."

• From a pre-built layout. The pre-built layout provides a screen-wide top container, two sets of
three columns, and a footer at the bottom.
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Figure 2-6: A page created with Dreamweaver's Bootstrap pre-built layout.

• Container by container.

Figure 2-7: Building a page container by container in a Dreamweaver Bootstrap site.

Bootstrap comes with its own CSS file, along with fonts and JavaScript. The first time you create a
new Bootstrap page in a site, Dreamweaver will copy the default Bootstrap CSS file into a new CSS
folder. (You will select Create new in the New document dialog box to make this happen.) If you
create your own layout, you can enter containers with a static width or fluid containers. You can also
enter a grid row with columns.
The default number of columns in the underlying grid is 12, and you can, of course, combine these
underlying columns into fewer larger columns. Your new page also includes several media queries.
You can edit the default sizes for these media queries when you create the page.
On Bootstrap pages, rows are bordered in gray dashed lines with rounded corners, and columns are
bordered in blue dashed lines.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Create a Bootstrap Page.
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ACTIVITY 2-4
Creating a Bootstrap Page

Data Files
All files in C:\092006Data\Writing_for_Mobile_Platforms\Topic_B\starter

Scenario
You have been working on making the Emerald Epicure home page more attractive and usable on
devices that have viewport sizes. You wonder if there is a quicker, more efficient way to accomplish
this task, and a colleague suggests that you use the Bootstrap framework to recreate your pages. As a
first step, you will create a page by using Bootstrap.
By the end of all the activities in this lesson, you will have created this page:
 

 

Note: Activities may vary slightly if the software vendor has issued digital updates. Your
instructor will notify you of any changes.

1. Create a new site for the company Emerald Epicure.
a) In the Files panel, select the Manage Sites drop-down list and select Manage Sites.
b) In the Manage Sites dialog box, select Emerald Epicure.

c) Select Edit the currently selected site. 
d) To the right of the Local Site Folder text box, select the folder button and browse to C:\092006Data

\Writing_for_Mobile_Platforms\Topic_B\starter.
e) Select Select Folder.
f) In the Site Setup dialog box, select Save.
g) In the box notifying you that the cache will be re-created, select OK.
h) In the Manage Sites dialog box, select Done.
i) Observe that the site's local folder contains only one subfolder, images, and that there are no files

outside of the images folder.

2. Start a Bootstrap page where you will create the layout.
a) On the Application Bar, select File→New. The New Document dialog box opens.
b) In the New Document dialog box, confirm that the Document Type is HTML.
c) Under Framework, if the Bootstrap tab is not already selected, select it.
d) In the Bootstrap CSS section, make sure that Create new is selected.
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e) Deselect Include a pre-built layout.
f) Select Create.
g) On the File menu, select Save. Name the page index.html and select Save.

3. Observe files and folders created from the Bootstrap template.
a) If Live view is not displayed, select the Switch to Live View drop-down arrow and select Live view.
b) Select near the top of the page. Observe the body tag.
c) Observe several media queries on the query bar.
d) Observe three new folders in the Files panel: css, fonts, and js. If these folders do not appear, select

Refresh  in the Files pane.
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TOPIC C
Modify a Bootstrap Page
You have created a new page by using the Dreamweaver Bootstrap template. Assuming you have
not used the pre-built layout, you are now ready to add containers and content to your page and
style them.

Page Layout with Bootstrap
Bootstrap offers several classes of div tags for layout purposes: Container, Container-fluid, and Grid
Row with column.
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Figure 2-8: Bootstrap components on the Insert panel.

Container is one fixed width per media query and by default will center within its parent.
Container-fluid can extend to the full width of its parent tag. If the width of a device falls between
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the widths of your media queries, the contents of the Container-fluid div can still extend across the
device.
Grid row with column creates a grid based on the grid underlying the page template. If, when
creating the page, you used the default 12-column grid, you can combine those columns a variety of
ways. For example, you can create three columns, each of which uses four of the underlying
columns. Or, you could create two columns, with the left column combining eight underlying
columns and the right column combining only four underlying columns. After creating a Grid row
with column, you can add a row or column as needed. Columns in a grid row are assigned the
class .col-[xs, sm, md, lg] - [number of columns]. The media query targeted when the grid row is
created dictates whether the column will be labeled extra small, small, medium, or large.

Time-Saving Bootstrap Components
Bootstrap pages offer a variety of popular responsive components.

Component Uses and Variations

Navbar You can insert a Basic Navbar with link buttons and a search box. You
can insert an Inverted Navbar with a dark background and light text.

Carousel This slide show of images is hugely popular.

Responsive Image Choose one of several shapes: circular, rounded corner, or thumbnail.
Not all of the image shapes will display correctly in Internet Explorer 8.

Thumbnails The Thumbnails component inserts a small image placeholder with a
placeholder for text and buttons.

Media Objects Dreamweaver provides two types of media objects: Default media and
Media Lists. Both arrange a series of images with accompanying text for
each.

Glyphicons Glyphicons are small symbols. They include a home icon, envelope, and
hamburger.

Responsive Video
Embed

Your video resizes for different viewports.

Jumbotron Contents of a Jumbotron are displayed across the full width of the
screen. Jumbotrons can contain images, text, or other content.

Buttons Available buttons range from small to large and in a variety of colors.
Buttons can be inserted in groups, as drop-down lists, or as pop-up lists.

Form elements Bootstrap form elements include input groups, list groups, labels, panels,
and wells.

Navigation aids Organize your page with Tab, an Accordion, Pagination, or
Breadcrumbs.

Live View
In the Adobe® Dreamweaver® CC (2017): Part 1 course, you worked largely in Design view and to
some extent in Code or Split view. Live view, which is newer than Design view, originally was
read-only, providing a way to preview a page as it would appear in the browser. In Dreamweaver CC
2017, Live view is now the default view and much of your editing can be done there. Some types of
editing are easier in Live view, whereas other types of editing are easiest in Design view or even in
Code view. Some people find it easier to edit a Bootstrap page in Live view.
You will be using Live view in creating and modifying pages through much of this course.
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When you select a page element in Live view, the element will be surrounded by a blue line. In the
upper- or lower-left corner of the element, you will see the Element Display box, which contains the
name of the HTML tag followed by a plus sign. By selecting the plus sign you can apply a CSS class
to the page element, or assign an ID.

Figure 2-9: HTML tag visible in Element Display.

Figure 2-10: Element Display with ID.

Figure 2-11: Element Display with CSS class and ID.
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Adding and Editing Text in Live View
In Live view, you can add or edit text in a <p> tag or in a heading tag. When you nest one of these
tags within a <div> or semantic tag, placeholder text appears. To enter text, you must first replace
the placeholder text.

Figure 2-12: Placeholder text in a <p> tag, nested in a grid row column.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Lay Out a Page Created with Bootstrap.
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ACTIVITY 2-5
Adding and Arranging Page Elements on a
Bootstrap Page

Data Files
All files in C:\092006Data\Writing_for_Mobile_Platforms\Topic_B\starter

Before You Begin
The Emerald Epicure site is open. The index.html page you created in the "Creating a Bootstrap
Page" activity is open.

Scenario
Your home page is ready and waiting for content. Bootstrap has created CSS, fonts, and JavaScript.
You decide to provide IDs for your page elements to facilitate later editing. You and a colleague
have drawn an initial wireframe for your page layout and given some thought as to how you will use
Bootstrap to accomplish this.
 

 

1. Create a custom style sheet in the css folder and link it to the home page.
a) In the Files panel, right-click the css folder and select New File.

A new file appears in the Files list with the file name selected.
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b) Delete untitled.html and enter style.css as the file name.
 

 
c) Select the document window to select the index.html page.
d) On the Application Bar, select File→Attach Style Sheet.

 

 
e) In the Attach Existing CSS File box, select Browse and navigate to the css folder. Select style.css.
f) Select OK.
g) In the Attach Existing CSS File box, verify that Link is selected.
h) Select OK.

2. Add a container for all page contents.

a) On the Visual Media Query bar, select the media query min-width 992 - max-width 1199.
 

 
b) In Live view, select the body tag.
c) From the drop-down list at the top of the Insert panel, select Bootstrap Components.
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d) Select Container.
A div with the container class appears within the body tag.

3. Add a Grid Row with column to contain the Emerald Epicure logo and navigation.
a) On the Insert panel, select Grid Row with column.

The Insert row with columns dialog box appears.
 

 
b) In the Insert row section, select Nest to place your grid within the container div.
c) In the No. of columns to add text box, type 2

 

 
d) Select OK. Observe the blue dotted line between the two columns of your new row. Observe the

tags and classes in the Tag Selector. Observe the Element Display.
 

 

4. Change the row's div tag to a semantic header tag.
a) With the new div tag still selected, switch to Split view.
b) In the element <div class="row">, select div and type header
c) Within the header tag, add id="logo-and-nav-grid"
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d) Select the associated closing </div> and substitute </header>
Your code should look like this:
 

 
e) Select Live view.
f) Observe the Element Display for the new <header>.

 

 

5. Add a placeholder responsive image for the company logo and assign an ID.
a) Select the first column in the header.

 

 
b) On the Insert panel, select Responsive Image and from the pop-up list, select Default.
c) In the document window, from the positioning pop-up, select the Nest option.

 

 
d) In the Element Display for the image placeholder, select the plus sign ( + ) and enter #EE-logo

 

 
e) Make sure that Select a source is set to style.css.
f) Press Enter.

6. Add a navigation bar to the right-hand column in the grid row with columns.
a) Select the right-most column in the grid row with columns.
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b) In the Insert panel, select Navbar: Basic Navbar and, in the Position Assist dialog box, select Nest.
Your page so far looks like this:
 

 

7. Add a grid row with columns to house text on product background, history, and harvesting.
a) Right-click and, in the context menu, select Select Parent Tag.
b) Right-click and, in the context menu, select Select Parent Tag again.

The header row will be selected.
 

 
c) On the Insert panel, select Grid Row with column.
d) In the Insert row with columns box, in the Insert row section, select After to place your grid after the

header.
e) Make sure the No. of columns to add text box is set to 3
f) Select OK. Observe the blue dotted lines between the three columns of your new row. Observe the

tags and classes in the Tag Selector.
g) Use the Split view to replace div tags with semantic tags by making the following changes to the

code. Be sure to change closing tags.

div class="row" section class="row"

For all three columns:  

div class="col-md-4" article class="col-md-4"

Your code should look like this:
 

 

8. Add a responsive image to the first column in the row.
a) Select the first column in the <section> row.
b) In the Insert panel, select Responsive Image and then select Nest.
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c) In the Element Display, select the plus sign ( + ) and enter #salad to assign the ID.
 

 
d) Press Enter twice.

9. Add a responsive image to the second and third columns in the row.
a) Using the same method you used to add a responsive image to the first column, add a responsive

image to the second and third columns with the ids "urns" and "field," respectively.
b) Click outside of the document window and observe the page layout.

 

 

10. Save the layout.
a) Select File→Save All.
b) If the Copy Dependent Files box appears, select OK to allow the Image Placeholder image to be

saved within the site folder.

44  |  Adobe® Dreamweaver® CC (2017): Part 2

Lesson 2: Writing for Mobile Platforms  |  Topic C

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



ACTIVITY 2-6
Adding Content to a Bootstrap Page

Data Files
Data files are in the C:\092006Data\Writing_for_Mobile_Platforms\Topic_B\starter folder and
the page created in the Adding and Arranging Page Elements on a Bootstrap Page activity. If you
feel you may have made a mistake and would like to work from the files as they should be at this
point, you may use the Manage Sites dialog box to repoint the Emerald Epicure site to
Writing_for_Mobile_Platforms\Topic_B\additional_files.

Before You Begin
The Site Emerald Epicure is open. The Local folder for the site is still C:\092006Data
\Writing_for_Mobile_Platforms\Topic_B\starter, or you have switched it to
Writing_for_Mobile_Platforms\Topic_B\additional_files. The index.html page is open.

Scenario
You have created a layout and added containers to your Bootstrap home page. You have also added
placeholders for your images and a navigation bar. You now need to add images and text to the
page.

1. Specify the images in the first grid row.
a) In index.html, select the image placeholder in the top-most grid row on your page. The image

placeholder appears as a gray box with the ID #EE-logo.
b) In the Files panel, expand the images folder.

c) In the Properties Inspector, drag from the Src Point to File icon  to the file logo.png.
The Emerald Epicure logo appears.

2. Add the images and text in the second grid row.
a) In the second grid row, select the first img-responsive placeholder. This image placeholder appears

as a gray box with the ID #salad.
b) In the Properties Inspector, drag from the Src Point to File icon to the file salad.png.
c) With the salad image selected, in the Insert panel, select the HTML category and the Paragraph tag.
d) In the positioning pop-up, select Before.
e) Double-click the placeholder text in the new paragraph. An orange box appears around the text.

Select the placeholder text and enter The Saga of the Olive
f) Select outside the paragraph.

3. Add images and text to the second and third columns.
a) Using the same method you used to add an image and text to the first column, add images and text

to the second and third columns as follows:

Image File Paragraph Text

urns.png History of the Olive

field.png Cultivation and Harvest
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b) Select outside the row.
 

 

4. View the images and navigation bar for various devices.
a) View your images in various media queries.
b) To view the logo as it would appear on an iPhone 7, select the Window Size tool and select

iPhone7.
The logo is small enough to appear essentially the same in most viewport sizes. In the iPhone 7 and
similar sizes, the menu collapses to a hamburger icon.
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c) Select the hamburger icon.
When the hamburger icon is selected in Live view of the browser, a vertical menu of link
placeholders appears.
 

 
d) On the Application Bar, select File→Save.
e) Select Double click to fit width to set the document size to fill the available window.
f) Preview in the browser.
g) Close the browser tab displaying your page and return to Dreamweaver.

5. Save the file.
a) Select File→Save All.
b) Keep the file open.

Styles for Elements on a Bootstrap Page
Bootstrap components, including Bootstrap divs, are associated with built-in styles in the
bootstrap.css file. The bootstrap.css file is over 5,500 lines of read-only code. You can easily view
the CSS for a class or element ID by using the Filter box in the CSS Designer panel. You can
modify the style of bootstrap components by creating your own style sheet or by adding a style to
the HTML page. In effect, you will be creating styles that add properties to the default styles or
overrule properties of the default styles.
The @media rule in bootstrap.css provides styles for several viewport sizes. Several media queries
are built-in for various screen sizes and for printing. One of the built-in media queries has a
minimum width of 767 pixels; 767 pixels is a common smartphone size. You also have the option of
adding additional media queries and specifying a style for built-in or custom media queries.
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Note: For more information about writing CSS code, check out the LearnTO Implement Best
Practices for Writing CSS Code and LearnTO Work with Various Coding Features of
Dreamweaver presentations. You can access these presentations by clicking the LearnTO tile
on your CHOICE Course screen.

CSS Descendant Selector
Many built-in Bootstrap classes make use of descendant selectors. A class with a descendant selector
applies a style for each instance of tag x that occurs nested within tag y. For example, you might
want to format list item text as bold, but only when the list item is nested inside a nav tag. You
could accomplish your goal by writing a compound class such as the one in the following figure.

Figure 2-13: Descendant selector.

This rule would not impact list items outside a nav tag.
For more information on compound CSS classes, see "CSS Combinators" at
www.w3schools.com/css/css_combinators.asp.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Style a Bootstrap Div or Component.
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ACTIVITY 2-7
Styling Elements on a Bootstrap Page

Data Files
Data files are in the Writing _for_Mobile_Platforms\Topic_B\starter folder and the page created in
the Adding and Arranging Page Elements on a Bootstrap Page activity. Students who switched to
Writing_for_Mobile_Platforms\Topic_B\additional_files\index.html should continue with that file.

Before You Begin
The Site Emerald Epicure is open. The index.html page you modified in the "Adding and
Arranging Page Elements on a Bootstrap Page" activity is open.

Scenario
You have created a layout and added certain components to your Bootstrap home page. You now
need to style the components on the page.

1. Center and enlarge the text in the three-column grid.
a) Select the paragraph tag in the first column of the three-column grid.
b) At the top of the CSS Designer panel, verify that All is selected.
c) So that the new style will be added to the style.css file in the Sources section, select style.css.

d) In the Selectors section, select the plus sign. 
The new selector appears as .row .col-md-4 p because in the last exercise, you selected a
paragraph in a column that combines four underlying columns.
 

 
e) Press Enter.
f) If Show Set is selected, deselect it.
g) In the Properties section, select the Text icon to view text-related properties.

 

 
h) Set the color to #536C1F to set the text color to green.
i) From the font-size: drop-down list, select em and type 1.3
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j) Set the text-align property to center.
 

 
k) Observe that the paragraph text in all three columns is green and center-aligned.

2. Style the navigation bar.
a) Select any item in the navigation bar.
b) In the Tag Selector, select nav to select the navigation bar.

 

 

c) Select the plus sign  at the top of the Selectors section.
The new Selector appears as #logo-and-nav-grid .col-md-6 .navbar.navbar-default because when
you insert a default nav bar, the built-in bootstrap.css file assigns it the .navbar.navbar-default class.

d) Press Enter.
e) In CSS Properties, select the background category of properties.

 

 
f) Select the background-color drop-down list to display the color selection box. Type #6A8225 in the

box in lower-left portion of the color selection box.

3. Set the text of links in the nav bar to white.
a) Select the area just to the right of the link with the light gray background.

You are selecting a link that is difficult to see because of the green background applied to the nav
bar.

b) Select the plus sign  at the top of the Selectors section.
The new selector appears as .nav.navbar-nav li a because the built-in bootstrap.css file assigned
the .nav.navbar-nav li a class to the links in the list within the navigation bar when you inserted the
default nav bar.

c) Press Enter.
d) In CSS Properties, select the text category of properties.
e) Select the color: drop-down list to display the color selection box. Type #FFFFFF in the lower-left

portion of the color selection box.

4. Save and preview.
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a) Select File→Save All.
b) Select File→Real-time Preview→Internet Explorer. Your page will be similar to this example:

 

 
a) Close Internet Explorer.
b) Select File→Close All.
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Summary
In this lesson, you created media queries and used them to design an attractive page that is usable
across devices with different viewport sizes. You used the Bootstrap template to more efficiently
create responsive pages.

Given your target audience, which devices do you think they use, or will use, most often to access your
pages?

A: Answers will vary. Different target audiences tend to use different devices. You might ask selected
members of your target audience which devices they use most, or you might explore websites that
offer information on device usage for different demographic groups.

Which guidelines for writing mobile pages will be most important for your site?

A: Answers will vary, but may include adequately sized link text, avoiding excessive images that could
slow download, avoiding horizontal scroll bars, and hiding some items on smaller viewports.

Note: Check your CHOICE Course screen for opportunities to interact with your classmates,
peers, and the larger CHOICE online community about the topics covered in this course or
other topics you are interested in. From the Course screen you can also access available
resources for a more continuous learning experience.
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Creating Forms
Lesson Time: 1 hour

Lesson Introduction
You formatted web pages in order to enhance their appearance. You have used digital forms
on websites. As you develop your site, you may need to collect information from visitors,
such as opinions, customer or employee information, or feedback on your services.

Lesson Objectives
In this lesson, you will:

• Create a form with form fields.

• Validate a form.

3
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TOPIC A
Create a Form with Form Fields
You know that the design and layout of a regular web page requires thought and planning. In much
the same fashion, you will need to plan and lay out a form, and consider its placement in a page. To
make a form functional, you need to add data input fields.

Forms
A form is a page that collects data from users and submits the data to a server for processing. Every
single form on a web page has a unique name and contains input elements, or controls, and other
HTML features. For data to be transmitted from the form to the server, the form supplies the
browser with a path to the form page or script, which processes data and defines the method for
data transmission. Built on a combination of form elements and scripts that process data, each form
differs in its function and appearance.

Figure 3-1: A form with various elements.

Form Properties
Form properties are the features of a form that determine what happens to the form when it is
submitted.

Property Description

Form ID A distinct name given to a form on a web page.

Action The path specified to a page or script that processes a form.
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Property Description
Method A mode in which a form’s data can be submitted to a server.

Target The window where processed data is displayed.

Enctype The encoding format that needs to be applied to submitted data.

Class The type of CSS style that is applied to a form.

Form Processing Methods
The different methods by which information is processed in a form are called form processing
methods. Once a form is submitted, the data in the form is transferred to an email address, a server-
side application, or a Common Gateway Interface (CGI) script. If the data is delivered to an email
address, the receiver obtains the data in the form of an email message, which is then
processed. With ColdFusion or JSP, which are server-side applications, the page searches and
updates a database and returns the processed results to the browser in HTML. Data processing in a
CGI script is similar to a server-side application. In addition, the script redirects the request to
another HTML page, which is to be returned to the browser.
To send the information to the form processor, choose between the Get and Post actions. The Get
action places the names and values of the form fields in the URL of the form processor. Post
embeds the form data in the HTTP request.

Form Elements
A form element, also called a form field, enables users to enter their data directly in a form and record
the inputs. Each form element in a form has a unique name, and it saves the data that users enter.
After the form is submitted, the name and value pairs of all the form elements used are transferred
to a server, where they are processed.

Figure 3-2: Different form elements added to a form.

Types of Form Elements
Dreamweaver provides different types of form elements. Most of the elements listed in the
following table are fields in which the user enters information. The label element is simply a label for
a form field. This list is not exhaustive.

Adobe® Dreamweaver® CC (2017): Part 2  |  55

Lesson 3: Creating Forms  |  Topic A

Form Processing
Methods

Form Elements

Most Common Types of
Form Elements

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



Type Description

Text Field Accepts alphanumeric input.

Hidden Field Stores information a user enters in other fields, such as names and email
addresses, which is used by the script that processes the form.

Textarea Accepts several lines of alphanumeric input.

Checkbox Shows one option to be selected or deselected.

Checkbox Group Holds a collection of check boxes that can be selected or deselected.
Multiple options can be selected within a group.

Radio Button Displays one option among a group of options.

Radio Group Holds a group of radio buttons that represent exclusive options. All the
options have identical names, but hold different values. If one option in
the group is selected, all the other options are deselected.

List/Menu Displays a drop-down list that enables users to select a single item, or
displays a list box that enables users to select a single item or multiple
items.

Jump Menu Builds a menu that allows users to select an option to navigate to another
page.

Image Field Provides an image that can be used as a graphical button.

File Field Permits users to browse and select a file.

Button Executes a particular task when clicked. Mostly used to submit and reset a
form’s contents or execute scripts.

Label Shows descriptive text.

Email Intended for entry of an email address. If an entry in the field does not
include an @ sign, the browser will indicate that the entry is invalid.

Date When viewed in Google Chrome, the Date field offers the user a calendar
tool for selecting a date.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Create a Form with Fields and Field Properties.
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ACTIVITY 3-1
Creating a Form

Data Files
All files in C:\092006Data\Creating_Forms\starter

Scenario
As part of a marketing initiative, the marketing team has suggested that site visitors be allowed to
sign up in the company's website, so that they can receive product information, updates, and
information on various promotional offers on a regular basis. You decide to get started with the
creation of a form. To collect the required information from your website users, you have to
provide the necessary input fields in the form page.

1. Use the files in C:\092006Data\Creating_Forms\starter for the Emerald Epicure site.
a) In the Files panel, select the Manage Sites drop-down list, and select Manage Sites.
b) In the Manage Sites dialog box, select Emerald Epicure.

c) Select Edit site. 
d) Browse to C:\092006Data\Creating_Forms\starter.
e) Select Select Folder.
f) In the Site Setup dialog box, select Save.
g) If a box appears notifying you that the cache will be re-created, select OK.
h) In the Manage Sites dialog box, select Done.

2. Add a Form container.
a) Open the file signupform.html.
b) In Live view, select the h3 object containing the words "Interested in receiving newsletters? Sign

up!"
c) In the Insert panel, from the drop-down list at the top of the panel, select the Form category.
d) In the Form category, select Form and the position After.
e) Observe that a form HTML element has been added beneath the words "Interested in receiving

newsletters? Sign up!"

3. Set the form properties.
a) Verify that the form is selected or the insertion point is inside the form.
b) In the Property Inspector, in the ID text box, enter Signup to assign an ID to the form.
c) In the Action text box, enter action.cfm

Note: You are entering action.cfm as an example only. The file extension .cfm
refers to Cold Fusion Markup language. The server file that will process your
form could be one of several file types, each with its own file extension, such
as .cfm, .asp, .php, or .pl.

d) In the Method drop-down list, make sure that POST is selected.
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Note: The GET method appends input to the requested URL. It is often used
for search forms or to direct the site visitor to another page in the site. Thus,
the input is visible to anyone viewing the destination page. Input sent to the
server via the POST method is not visible in the URL. However, the
information being sent can be accessed by a hacker. If the information should
be secure, use a secure connection to a secure server.

e) Select File→Save.

4. Which form property is used to define the procedure by which a form's data is submitted to a server?
○  Form ID
○  Class
○  Method
○  Action

5. What are some of the most common uses of forms?
A: Answers will vary, but may include: to collect information and feedback from site visitors, conduct

surveys, perform business transactions, and provide login or search mechanisms.

6. Add text fields to the form.
a) Switch to Design view and position the insertion point inside the form you created.
b) Delete the placeholder text.

c) In the Form category, in the Insert panel, select Text  to generate the text field.
d) In the document window, add a title for the First Name field by replacing the text “Text Field:” with

First Name:
e) Select the First Name field. In the Property Inspector, in the Name box, select the text textfield and

type first_name
f) Position the insertion point after the blank text box, press Enter twice and, in the Insert panel, select

Text to generate the text field.
g) In the document window, add a title for the Last Name field by selecting the text "Text Field:" and

entering Last Name:
Your form should now include the following:
 

 
h) Select the Last Name field. In the Property Inspector, in the Name box, select the text textfield and

enter last_name

7. Add radio buttons and a label to the form.
a) Position the insertion point after the Last Name blank text box and press Enter twice.

b) In the Insert panel, select Label . Select Split view.
c) In the Code portion of the window, within the <label> tag, type Gender:
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d) Switch to Design view.

e) In the Insert panel, select Radio Button Group. 
The Radio Group dialog box is displayed.
 

 
f) In the Radio Group box, highlight the placeholder text in the Name text box and enter Gender
g) Select the placeholder text Radio in the first row under the column header Label. Type Male
h) Press Tab. The placeholder text radio under the Value column header is selected. Type male
i) Press Tab. In the Label column, enter Female
j) Press Tab. In the Value column, enter female

 

 
k) Select OK.
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l) Position the insertion point after the word Male and press Delete to place both Radio buttons on the
same line.

8. Add a drop-down list to the form.

a) At the end of the label "Female," press Enter twice and, in the Insert panel, select Select. 
b) Select the placeholder text “Select:” and type Country:
c) Right-click the empty drop-down box. From the pop-up menu, select List Values.

 

 
d) In the List Values dialog box, in the Item Label column, type Canada and press Tab.
e) In the Value column, enter can
f) Select the plus sign ( + ) in the upper-left of the List Values dialog box and, in the Item Label column,

type US and press Tab.

Note: You can also use the Tab key to create a new list value.

g) In the Value column, enter usa
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h) In the List Values dialog box, select OK.
Your form now includes:
 

 

9. Add an email field.
a) Position the insertion point after the Country drop-down box and press Enter twice to move down

two lines.
b) In the Insert panel, select Email.

10. Add a field that will require a numeric value. The field will inquire how many jars of olives the user has
purchased.
a) Position the insertion point after the Email field and press Enter twice to move down two lines.
b) In the Insert panel, select Text to generate the text field.
c) In the document window, add a title for the field by selecting the text “Text Field:” and entering How

many jars of olives have you purchased this year?
d) Select the new field. In the Property Inspector, in the Name box, select the text "textfield" and type

jars-purchased

Note: You will configure this field to only allow numeric input in the next
activity.

11. Add the Submit and Reset buttons to the form.
a) Position the insertion point after the last text box and press Enter twice.

b) In the Insert panel, select Submit Button. 
c) Position the insertion point to the right of the Submit button, and in the Insert panel, select Reset

Button. 

12. Save and preview the form.
a) Select File→Save.
b) Preview the page in your preferred browser, then close the browser.
c) Keep the signupform.html file open.
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TOPIC B
Validate a Form
You have inserted form fields in your form. To ensure that users enter the right type of data in those
form elements, you will need to set up a validating mechanism.

Form Validation
Form validation is the task of verifying if the data entered in a form is valid, meaning that it meets
criteria that you set. This can be done either on the client side or server side. The form validation on
the client side is done using scripts, such as JavaScript or jQuery Widgets. The validation on the
server side is performed by scripts that are written to process the form.
Dreamweaver provides quick, easy methods for creating certain types of client-side validation. You
can require a field. You can require a numeric value in a field. The email field is automatically
validated, meaning that it is checked for an @ symbol.

Figure 3-3: A form validated by using scripts.

Date Fields
Invalid form field data entry messages vary in appearance in different browsers. Microsoft Edge™
and Google Chrome™ force entry of numbers in the date field, whereas Internet Explorer® does
not.
The way the field is displayed on the page in the browser varies as well. In Microsoft Edge and
Chrome, a date field is displayed with a mm/dd/yyyy mask. In Internet Explorer, it is displayed as a
free-text field. In the Edge and Chrome browsers, when you click in the Date field, a date picker is
displayed. This is a way of ensuring that a valid date is entered in the form.

62  |  Adobe® Dreamweaver® CC (2017): Part 2

Lesson 3: Creating Forms  |  Topic B

Form Validation

Date Fields in Edge and
Internet Explorer

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



Figure 3-4: Date field displays differently in different browsers.

The Validate Form Behavior
The Validate Form behavior can be used to check whether or not the values in specific text fields are
numeric and if numeric, whether they fall within a range of values. Validate Form behavior can also
be used to require a field and to require the @ sign in an email field. However, each of these two
validations can be accomplished through another method: Dreamweaver's email field automatically
requires an @ sign, and the Properties Inspector can be used to require input in a field. The validity
of Dreamweaver's email field and completion of fields marked Required in the Properties
Inspector will be checked when the Submit button is selected. If you use the Behaviors panel to
validate fields, you can specify that the field will be validated onSubmit, onBlur, or onChange.
Although the onBlur and onChange events are similar, they are not the same. The onBlur event
occurs as the user leaves the field. The onChange event checks validity only if the user changes the
field's value. Thus, the onBlur event is particularly useful if you wish to validate whether or not the
user makes a change to the field.
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Figure 3-5: The Validate Form dialog box.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Validate a Form.
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ACTIVITY 3-2
Validating a Form

Data Files
All files in C:\092006Data\Creating_Forms\starter, as modified in the previous exercise

Before You Begin
The signupform.html file is open and the previous activity has been completed.

Scenario
In the form that you are developing on the signupform.html web page, you need to gather data,
such as visitor's email addresses. You need to ensure that visitors enter their first and last names.
Your marketing department has asked you to be sure to ask how many jars of olives users have
purchased in the past month.

1. Use the Properties Inspector to require entries into the first and last name fields.
a) If Design view is not active, switch to Design view.
b) Select the First Name field in the form. Be sure to select the input field box and not the label.
c) In the Properties Inspector, check the Required check box.
d) Select the Last Name field in the form. Be sure to select the input field box and not the label.
e) In the Properties Inspector, check the Required check box.
f) Save the file.

Note: The Email field provided in Dreamweaver's Insert panel will
automatically check for the presence of an @ sign. You do not need to set a
property to trigger this.

2. Require that a number be entered in response to the question "How many jars of olives have you
purchased this year?"

a) Select any of the form fields. Use the Tag Selector to select the form tag.
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b) On the Application Bar, select Window→Behaviors.
 

 

c) Select the plus sign  in the Behaviors panel.
A pop-up menu appears.

d) From the pop-up menu, select Validate Form.
e) In the Fields list, select input "jars_purchased".
f) In the Accept section, select Number.

 

 
g) Select OK.
h) In the Behaviors panel, set the value to the left of Validate Form to onBlur.
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i) Close the Behaviors panel.
j) On the Application Bar, select File→Save.

3. Complete the sign-up form to test the validation settings.
a) Preview the web page in Internet Explorer by selecting File→Real-time Preview→Internet Explorer.
b) Leave the First Name text box blank.
c) In the Last Name text box, type David
d) In the Gender section, select the Male radio button.
e) From the Country drop-down list, select US.
f) In the Email field, enter David
g) For the question "How many jars of olives have you purchased this year?" enter many
h) Select Submit and observe the messages and red highlighting that indicate the First Name field is

required and the red highlighting that indicates the Email field is incorrectly filled out.
i) In the First Name field, type John and in the Email field, change the text to

john.david@example.com
The fields turn white, indicating that the input has been accepted.

j) Press Submit. Depending on your browser, the Submit button may be labeled Submit Query.
k) Observe the error message prompting the user to enter a number in the jars-purchased field. Close

the error message.
l) In the Jars-purchased text box, enter 5
m) Press Submit. Depending on your browser, the Submit button may be labeled Submit Query.
n) Close Internet Explorer.
o) Close all open files.
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Summary
In this lesson, you created forms and validated form fields. Forms have become one of the integral
features of a website and enable you to collect information or feedback from your site users.
Dreamweaver enables you to develop and validate forms easily and quickly by means of built-in
form elements.

What are some of the best practices that you have implemented when developing a form page?

A: Answers will vary, but might include placing the form fields in a logical sequence, setting up form
validation for all critical fields, displaying error messages that clearly indicate what needs to be
entered in that particular field, and sequentially setting up the tab order.

What are some of the form validation techniques that you will you use to check for valid user input?

A: Answers will vary, but might include email field validation to ensure that a user enters the email
address in its proper format, requiring a field, or requiring that a text box contains a number.

Note: Check your CHOICE Course screen for opportunities to interact with your classmates,
peers, and the larger CHOICE online community about the topics covered in this course or
other topics you are interested in. From the Course screen you can also access available
resources for a more continuous learning experience.
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Creating Movement
Lesson Time: 30 minutes

Lesson Introduction
You have created layouts that will look good when displayed on multiple devices, including
smartphones and tablets. You have also created usable, effective forms.
Given competition between web pages and user expectations, web designers increasingly
must use strategies such as movement to maintain user interest, keep users on a page longer,
and encourage return visits. You may also need to create movement to display more
information in a compact space or to make a specific point. You can use Dreamweaver to
add movement by using behaviors and CSS transitions.

Lesson Objectives
In this lesson, you will:

• Create movement with CSS Transitions.

• Add behaviors.

4
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TOPIC A
Apply CSS Transitions to Create Movement
You learned the basics of CSS and how to use CSS Designer in Adobe® Dreamweaver® CC (2017): Part
1. You have used CSS to format the appearance of pages on desktop and mobile devices, and to
control the appearance of elements on a form.
Web designs often call for movement on a page. In order to use CSS to provide movement, you
must create a transition.

Benefits of Creating Movement
Movement on a page can offer several benefits.
• It can enhance user interest.
• Users may stay on a page longer due to visual interest.
• Movement can encourage return visits to the site.
• You can use movement to display more information in a compact space.
• Dynamic content can illustrate certain points more effectively than static content.

CSS Transitions
CSS Transitions provides a powerful way to implement animation effects on your web pages. You
can allow your animations to change in a fluid motion rather than changing abruptly. By using the
CSS Transitions panel, you can apply transition effects by selecting a CSS rule you want to target,
selecting an event (for example, hover), and selecting which properties will change during the
animation. These transitions are supported by most modern browsers.

Figure 4-1: CSS Transitions.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Create Movement with CSS Transitions.
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ACTIVITY 4-1
Creating Movement with CSS Transitions

Data Files
All files in C:\092006Data\Creating_Movement\starter

Before You Begin
Dreamweaver is open.

Scenario
After formatting the index.html file, you feel that the web page offers a great deal of text that does
not sufficiently engage users. You decide to apply a transition effect to the article containers so that
some of the text is displayed when the mouse pointer hovers over images.

1. Use the files in C:\092006Data\Creating_Movement\starter for the Emerald Epicure site.
a) In the Files panel, select the Manage Sites drop-down list and select Manage Sites.
b) In the Manage Sites dialog box, select Emerald Epicure.

c) Select Edit site. 
d) Browse to C:\092006Data\Creating_Movement\starter.
e) Select Select Folder.
f) In the Site Setup dialog box, select Save.
g) If a box appears, notifying you that the cache will be re-created, select OK.
h) In the Manage Sites dialog box, select Done.

2. Observe an existing style.
a) Open index.html.
b) Switch to Code view.
c) Above the Document toolbar, select style.css.
d) Scroll down to find the .animation1 rule.
e) Observe that the opacity is set to 0%.

 

 

3. Format the text that will be animated by using an existing style rule.
a) Switch to Live view.
b) Select the p tag for the text below the "Saga of the Olive" image.
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c) To add the class .animation1 to the p tag, in the Element Display, select the plus sign ( + ) and
enter .animation1
The text below the image is no longer visible, as the opacity property was set to 0.

d) Similarly, apply the class .animation2 to the <p> tag following the image of urns, and apply the
class .animation3 to the <p> tag following the image of a field.

4. Fine-tune the position of the text on top of the images by resizing the Article container.
a) In the CSS Designer panel, under Sources, select style.css.

b) In the CSS Designer panel, under Selectors, select the plus sign  and type #Article1, #Article2,
#Article3

c) Note: You can efficiently apply a style to multiple IDs. Use CSS Designer to
create a selector with several IDs separated by a comma.

Press Enter twice.
d) In the Properties section, if Show Set is selected, deselect it.
e) Click after max-height: and, from the pop-up menu, select px. Type 240
f) Click after display: and, from the pop-up menu, select block.
g) In the padding property box, make sure the lock icon is open. At the bottom of the box, click on 0px

and type 10px
h) Select the position property, and from the pop-up menu, select relative.
i) Select the overflow-x property, and from the pop-up menu, select hidden.
j) Select the overflow-y property, and from the pop-up menu, select hidden.
k) In Live view, verify that each of the articles is now just tall enough for the title and images.

5. Observe that the text formerly below the images is no longer visible in the browser.
a) Select File→Save All.
b) Select File→Real-time Preview and select the desired browser.
c) Observe that the text which was below the images is no longer visible.
d) Close the browser.

6. Apply a transition effect to the article containers to make the associated text appear on hover.
a) On the Application Bar, select Window→CSS Transitions.

b) In the CSS Transitions panel, select the Create New Transition button. 
c) In the New Transition dialog box, from the Target Rule drop-down list, select .animation1.
d) From the Transition On drop-down list, select hover.
e) In the drop-down list below the Transition On drop-down list, make sure that Use the same transition

for all properties is selected.
f) In the Duration text box, type 0.75 and, in the drop-down list to the right of it, verify that s is selected.
g) In the Delay text box, type 0
h) From the Timing Function drop-down list, select ease.

i) In the CSS Designer Property section, select the plus sign  and select opacity.
j) In the End Value text box, type 1
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k) Verify that the New Transition box looks like this:
 

 
l) Select Create Transition.
m) With the CSS Transitions panel still open, hover the mouse pointer over the "Saga of the Olives"

image and observe that the associated text appears.

7. Add the transition effect to the remaining columns.
a) Animate the text below the "History of the Olives" image and the "Cultivation and Harvest" image,

using the same method you used in the first column.

Container Rule to apply

Article2 .animation2

Article3 .animation3
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b) Observe the Transitions panel.
 

 
c) Close the CSS Transitions panel.

8. Save and preview the web page.
a) Select File→Save All.
b) In Internet Explorer, select File→Real-time Preview and select the desired browser.
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c) Move the mouse pointer over the images and observe that the corresponding text is displayed over
them.
 

 
d) Leave all files open.
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TOPIC B
Apply Behaviors to Create Movement
You have formatted web pages and applied transition effects to a few elements that dynamically
varied the display of text over an image. To apply some types of movement, web designers must go
beyond transitions and use behaviors.

Behaviors
A behavior is an aggregate of an event and an action that is triggered by the event. When behaviors
are applied to page elements, a specific type of user interaction will provoke the action, which will
display the element along with the desired effect. Behaviors can be applied to different page
elements by using the Behaviors panel.  

The Behaviors Panel
New behaviors can be created and applied to different page elements such as text, images, or links
by using the Behaviors panel. A few or all of the parameters of behaviors can also be modified
here. Various options are available on the Behaviors panel.

Figure 4-2: The Behaviors panel.

The Behaviors panel provides several options to further define or manage a behavior.

Option Description

Show set events Lists all the events that are applied to a specific page element.
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Option Description
Show all events Lists all the events that are supported by an element by default. The

events are displayed in alphabetical order.

Add behavior Lists a set of behaviors that can be applied to different elements in a
web page.

Remove event Removes the selected event.

Move event value up Moves the selected event one step up.

Move event value down Moves the selected event one step down.

Available Behaviors
Several built-in behaviors, which can be applied to different page elements, are available in
Dreamweaver.

Behavior Function

Call JavaScript A custom JavaScript function is called when an event occurs.

Change Property The value of an object’s property is changed.

Check Plug-in Plug-ins installed on users’ systems are checked. Based on the plug-in,
users are redirected to different pages.

Drag AP Element An AP element is allowed to be dragged.

Effects A visual effect is added to an element.

Go To URL When a link is clicked, a new page is opened in the current window.

Jump Menu Users are allowed to select a web page from the menu and navigate to
it.

Jump Menu Go A Go button is applied to the Jump menu so that the behavior is
enabled when users click the button.

Open Browser Window When a link is clicked, a web page is opened in a new window.

Pop-up Message A JavaScript alert message as described by the developer is displayed.

Preload Images The images that are not displayed during the initial loading of a web
page are cached and displayed faster the next time the web page is
requested.

Set Text The original text is set or replaced with new text or with a different
formatting style.

Show-Hide Elements The visibility of an element is controlled. It is shown, hidden, or
restored.

Swap Image A rollover effect is created by replacing an image with another.

Swap Image Restore The swapped image is made invisible and the original image is restored.

Validate Form The input data in a form is validated to ensure that the user had
entered valid types of data.

You can get additional behaviors. From the Add behavior drop-down list, select Get More
Behaviors. Your browser will open to an Adobe Add-ons page where you can select additional
behaviors to download and add.
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Behavior Events
The following table describes the different events that are available for most browsers to trigger
behaviors.

Event Triggers a Behavior When Users

onBlur Select an element in the page. The focus is then moved away from the
element.

onClick Click at a specified location on the web page.

onDblClick Double-click at a specified location on the web page.

onFocus Focus a specified element on the web page when it is selected.

onKeyDown Keep pressing down a key.

onKeyPress Press a key.

onKeyUp Release a key.

onMouseDown Click the left mouse button on a specified location on the web page.

onMouseMove Move the mouse pointer.

onMouseOut Move the mouse pointer away from a specified location on the web page.

onMouseOver Hover the mouse pointer over a specified location on the web page.

onMouseUp Release the mouse button.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Create a Behavior.

78  |  Adobe® Dreamweaver® CC (2017): Part 2

Lesson 4: Creating Movement  |  Topic B

Behavior Events

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



ACTIVITY 4-2
Adding Movement with a Behavior

Data Files
All files in C:\092006Data\Creating_Movement\starter

Before You Begin
The local folder of the active website is C:\092006Data\Creating_Movement\starter and the
previous activity has been completed.

Scenario
You have applied a transition effect to the article containers on the home page. You decide that the
Harvest page would also be more interesting with some interactive movement. You decide to use
the Swap Image behavior so that when the user moves the mouse pointer over the harvest tool
image, the pointer will be replaced with an image of an olive jar.

1. Assign an ID to the harvest tool image.
a) Open the harvest.html file.
b) Select the harvest tool image.
c) In the Properties Inspector, in the ID field, enter harvest_tool

2. Create a behavior to swap the image on mouse over.
a) Switch to Design view.
b) Make sure the harvest tool image is still selected.
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c) Select Window→Behaviors.
The Behaviors panel opens.
 

 
d) Select the plus sign and, when the pop-up menu appears, select Swap Image.
e) Verify that the image "harvest_tool" is selected.
f) In the Set source to line, select Browse.

The Select Image Source dialog box appears.
g) Browse to the C:\092006Data\Creating_Movement\starter\images folder and select olive_jar.jpg.
h) Select OK.
i) In the Swap Image dialog box, make sure that Preload images is selected so that the image will

download with the page and be available for a quick smooth swap.
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j) Make sure that Restore images onMouseOut is selected so that the harvest_tool image will
reappear when the visitor moves the mouse pointer away from the image.
 

 
k) Select OK.
l) Close the Behaviors panel.

3. Preview the image rollover.
a) Select File→Save All.
b) Select File→Real-time Preview and select your preferred browser.
c) Note: You may need to select an Allow blocked content button at the top of

your browser in order to view the Swap Image behavior.

Roll the mouse pointer over the harvest tool image to view the jar of cured olives.
d) Close the browser.
e) In Dreamweaver, select File→Close All.
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Summary
In this lesson, you have created movement to add interest to a page. You used two methods for
creating movement, CSS Transitions and the Behaviors panel.

Are there portions of your website that would be enhanced by adding movement?

A: Answers will vary and could include certain blocks of text or images, such as product descriptions or
images, staff pictures, or any items that the student wants to make more eye-catching.

What kind of movement might you apply to these elements on your site?

A: Answers will vary and could include behaviors such as displaying a pop-up message; applying
behavior effects such as fade, slide, or fold; or swapping an image. Other answers might include
using CSS Transitions to modify text or image properties such as size, position, or color.

Note: Check your CHOICE Course screen for opportunities to interact with your classmates,
peers, and the larger CHOICE online community about the topics covered in this course or
other topics you are interested in. From the Course screen you can also access available
resources for a more continuous learning experience.
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Adding Multimedia
Lesson Time: 30 minutes

Lesson Introduction
You have already explored how adding movement to a web page can enhance interest and
engagement with transitions and behaviors. You can also capture your audience's attention
with carefully chosen and well placed audio and video files.

Lesson Objectives
In this lesson, you will:

• Insert an audio file.

• Insert a video file.

5
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TOPIC A
Insert Audio Files
You may wish to add a spoken narrative to provide information, sway opinion, or inspire a
purchase. Or perhaps you wish to inspire positive feelings with music appropriate for your audience
and content. For whatever reason, Dreamweaver makes this process quick and easy.

Benefits of Multimedia Files
Aspects of multimedia add interest and complexity to a web page. The many benefits of multimedia
include the following:
• Capture user interest.
• Encourage return visits to the site.
• Display of more information in a compact space.
• Illustrate certain points more effectively than static content.
• Amuse and enhance interest.
• Relax and associate positive feelings with your site (particularly music).
While audio and video offer many benefits, before inserting multimedia be sure it is appropriate for
the target audience, relevant to the page content, and adds value.

HTML5 <Audio> Element
The HTML5 <audio> element specifies a standard way to embed audio in a web page. The controls
attribute of the <audio> element adds play, pause, and volume controls. The source attribute points
to the source file. You may choose to provide multiple source files so that if a browser cannot play
the first source option, it can attempt to play the second option. Selecting the autoplay attribute
starts the audio upon page load. Be careful of this choice. Many people do not like to hear audio
immediately on opening a page, unless they expected the page to play audio.

Types of Audio Files
As of publication, three file formats are supported for the <audio> element: MP3, OGG, and
WAV.
In general, these three file formats are supported by recent versions of the major browsers (Internet
Explorer, Chrome, Firefox, Safari, and Opera) with the following exceptions:
• Internet Explorer does not support WAV or OGG files.
• Safari does not support OGG files.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Insert an Audio File.
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ACTIVITY 5-1
Inserting an Audio File

Data Files
All files in C:\092006Data\Adding_Multimedia\starter folder

Before You Begin
Dreamweaver is open.

Scenario
As part of your efforts to make your web pages more engaging, you identified a place where you
think the inclusion of an audio file will make the web page more interesting to users.

1. Use the files in C:\092006Data\Adding_Multimedia\starter for the Emerald Epicure site.
a) In the Files panel, select the Manage Sites drop-down list, and select Manage Sites.
b) In the Manage Sites dialog box, select Emerald Epicure.

c) Select Edit site. 
d) Browse to C:\092006Data\Adding_Multimedia\starter.
e) Select Select Folder.
f) In the Site Setup dialog box, select Save.
g) If a box appears notifying you that the cache will be re-created, select OK.
h) In the Manage Sites dialog box, select Done.

2. In the Files panel, open the signupform.html file.

3. Insert an audio file in the web page.
a) In Live view, select the farm image. The image may be to the right of the form or below the form,

depending on your document window width.
b) In the Insert panel, select the HTML category and then select HTML5 Audio.
c) In the positioning pop-up, select After so that the audio controls are positioned immediately after the

image.
d) Display the Files panel.
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e) In the Properties Inspector, drag from the Source Point to File icon  to the file EE_audio.mp3.
 

 
f) In the Properties Inspector, make sure Controls is checked so that playback controls will be visible

to the user.
g) In the Properties Inspector, check Autoplay so the audio will play once when the page opens.
h) In the Properties Inspector, confirm that Loop is not selected. The audio will play only once.

4. Style the audio controls to fit within the column but not be overly wide.
a) With the audio control still selected, in the Element Display, enter #EEAudio

 

 
b) In the pop-up window, make sure that under Select a source, style.css is listed.
c) Press Enter twice.
d) In CSS Designer, in the Selectors filter box, enter #EEAudio

#EEAudio appears in the Selectors list.
e) Select #EEAudio.
f) In the Properties pane, double-click after width: and enter 100%
g) Double-click after max-width: and enter 400px

5. Preview the web page in a browser.
a) Select File→Save All.
b) Select File→Real-time Preview and select your preferred browser.
c) Observe that the audio plays on the web page. Observe that the audio controls are no wider than

the image.
d) Resize the window until the column containing the audio wraps to underneath the form. Observe

that the audio controls are not overly wide.
e) Close the browser.
f) Close the signupform.html file.
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TOPIC B
Insert Video Files
You have added an audio file to create a mood or convey information. To add a video file, you will
need to select the correct file format and configure controls.

HTML5 Video Tag
HTML5 provides an open standard for including multimedia elements in web pages. Recent
versions of Chrome, Internet Explorer, Firefox, Safari, and Opera all support the HTML5 video
element. The HTML5 tags support the inclusion of closed captions and text transcripts within a
video.

Attributes Descriptions

Controls Adds play, pause, and volume controls.

Width and height If the width and height are not set, the page might change as the video loads.
This change will appear to the user as a flicker.

Source Specifies the file. You may choose to provide multiple source files, so that if a
browser cannot play the first source option, it can attempt to play the second
option.

Poster An image file that is displayed when the video is not playing.

Autoplay Selecting this attribute starts the video upon page load. Be careful of this
choice. Many people prefer to start a video using the controls,.

Types of Video Files
As of publication, three file formats are supported for the <video> element: MP4, OGG, and
WebM.
In general, these three file formats are supported by recent versions of the major browsers, Internet
Explorer, Chrome, Firefox, Safari, and Opera, with the following exceptions:
• Internet Explorer does not support WebM or OGG files.
• Safari does not support WebM or OGG files.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Insert a Video File.

Adobe® Dreamweaver® CC (2017): Part 2  |  87

Lesson 5: Adding Multimedia  |  Topic B

HTML5 Video Tag

Types of Video Files

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



ACTIVITY 5-2
Inserting a Video File

Data Files
All files in C:\092006Data\Adding_Multimedia\starter

Scenario
You have added the necessary graphics and text on your web pages. However, some of your peers
suggest that a certain section of a web page is better represented in the form of a video file, so that
the web page grabs users’ attention as well as conveys the idea more effectively.

1. In the Files panel, open the history.html file and switch to Live view if it is not already displayed.

2. Insert video by using the Insert panel.

a) In the document window, select the column to the right of the History text container.
 

 
b) In the Insert panel, select the HTML category and then select HTML5 Video.
c) In the positioning pop-up, select Nest so that the video is positioned within the column.
d) Display the Files panel.

e) In the Properties Inspector, drag from the Source Point to File icon  to the file
history_video.mp4.

f) In the Properties Inspector, confirm that Controls is selected so that playback controls will be visible
to the user.

g) In the Properties Inspector, check AutoPlay.
h) Display the Files panel and expand the images folder.
i) In the Properties Inspector, drag from the Poster Point to File icon to the history_video_poster.png

file.

3. Preview the web page in a browser.
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a) Select File→Save to save the file.
b) Preview the web page in your preferred web browser.
c) Observe that the video plays on the web page.

 

 
d) Close the browser.
e) In Dreamweaver, select File→Close All.
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Summary
In this lesson, you added external media files on your web pages. Integrating multimedia elements—
such as video and audio files—enhances the appeal of your web pages. Also, multimedia elements
complement the text on your web pages and help communicate the intent of your website to users
more effectively.

Is there content you would like to present on your site that might best be presented in audio or video files?

A: Answers will vary. Consider presenting a video or audio file about a product or service, the
organization's history or mission, educational information, or content aimed at changing opinions.

Given what you know about the devices and browsers used by your target audience, what types of video or
audio files would be apt to reach most of them?

A: Answers will vary. Consider the age and income level of the target audience in making this decision,
and also whether the target audience accesses the website from home or from work. For an intranet
site where employees use Internet Explorer 11, avoid OGG video files.

Note: Check your CHOICE Course screen for opportunities to interact with your classmates,
peers, and the larger CHOICE online community about the topics covered in this course or
other topics you are interested in. From the Course screen you can also access available
resources for a more continuous learning experience.
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Marketing Through
Social Media and Email
Lesson Time: 1 hour

Lesson Introduction
Just a few years ago, attracting the attention of search engines was almost the entire game of
getting the attention of your target audience on the web. While Search Engine Optimization
is still important, organizations must harness the power of social media and email marketing
to stay competitive.

Lesson Objectives
In this lesson, you will:

• Plan a strategy for using social media to attract site visitors.

• Add links to social media sites.

• Create email marketing materials and newsletters.

6
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TOPIC A
Plan a Social Media Strategy
Given the proliferation of platforms and variety of possible approaches, you will need a carefully
crafted plan to accomplish your social media goals.

Benefits of Social Media Marketing
The term social media refers to the means by which people interact and build relationships on various
virtual communities and networks. Participants share and exchange user-generated content that
includes opinions, ideas, analysis, data, pictures, videos, and more.
Social media is a powerful tool for sales, marketing, education, changing attitudes and even swaying
public opinion. Many, if not most, companies, organizations, and government agencies maintain a
presence on the most widely used social networks. Through social media, organizations can see
many benefits, including:
• Expanding their online presence to reach more people or new groups of people
• Thought leadership: by demonstrating expertise, organizations can become known and trusted in

their industry, which translates into sales
• Market research
• Marketing and advertising
• Building brand awareness

Brief Overview of Social Media Strategizing
An effective social media marketing strategy requires thoughtful, in-depth planning integrated with
the organization’s overall marketing, public relations, and customer service strategies. A productive
strategy includes analysis and planning related to the topics listed here, among others:
• Organizational readiness to launch a social media campaign.
• Organizational goals: Consider long-term and short-term business goals. Explore whether

problems faced by your organization could be resolved or reduced through social media. The
social media campaign should be aligned with identified organizational goals.

• Market segments, targeting.
• Competitors and their social media efforts.
• Specific goals for your social media campaign.
• The most suitable social media platforms, in light of the above.
• Types of content (text, images, video, slides, how-to information) and topics.
• How you will manage your efforts in the campaign and how you will manage the online

community.
• How you will measure results and make optimal adjustments. In other words, decide on a

method for measuring progress toward your goals. Before launching the campaign, define key
performance indicators (KPIs). A KPI is a metric that is measurable and can be used to gauge whether
or not activities are progressing toward a defined goal. For example, if the goal is to post 30 blog
posts a month, the KPI might be one blog post per day.

Social Media Platforms
The social media landscape continues to evolve at a rapid pace. There are many types of platforms.
Individual platforms come and go, and their popularity and demographics change over time.
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Platforms are sometimes referred to as channels. Before you select a platform, be sure you have
defined your target audience and your goals. Some of the most popular social media sites are:
• Facebook
• Google+
• YouTube
• Twitter
• LinkedIn
• Pinterest

Platforms and Goals
Each social media platform is best at achieving specific goals. The following table rates selected
social media platforms based on three common goals.

Platform Goal: Increase Site
Traffic

Goal: Increase Brand
Awareness

Goal: Customer
Engagement

Facebook Good Good Good

Twitter Good Good Good

LinkedIn Moderate Good Moderate

YouTube Moderate Good Good

Google+ Moderate Good Good

Platforms, Popularity, and Demographics
Because the popularity of social media types and sites, along with user demographics, change so
rapidly, how do you keep track of which is best for you? Some widely used resources you can use to
determine this are:
• Pew Research: http://pewinternet.org. Search the site for social media.
• Nonprofit Quarterly: http://nonprofitquarterly.org/2013/09/26/the-demographics-of-

users-of-social-media-summarized/
• Ragan Communications: www.ragan.com. View an infographic on the Pew report at

www.ragan.com/Main/Articles/47119.aspx. See also Ragan’s A to Z guide for social media
at www.ragan.com/Main/Articles/46237.aspx. Additional information on trends can be
gleaned by searching the site for social media demographics or social media trends.

• Mobile Marketing Watch: www.mobilemarketingwatch.com. The site offers updates on
trends in social media usage and approaches.

In terms of popularity, Google+ and Pinterest are growing. Facebook has gained middle-aged users
and lost market share among millennials.

Branding and Keywords
In crafting the look and copy of the page, plan for consistent branding and effective keywords.
The social media site should promote the organization’s branding. Where possible, those visiting
your social media site or following your feed should be seeing your logo, your colors, and the
verbiage you use to describe your products and services. Ideally, they should, in effect, “know where
they are” before even reading the text.
One of the first steps in developing a social media marketing plan is determining how to help people
who might be interested in your services locate you online. One of the most powerful methods is to
ensure that your site is prominently displayed when potential customers use a search engine to find
your type of product or service.
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The search words or phrases potential site visitors type into search engines are known as keywords.
You or a colleague have probably already selected keywords for your web pages. You may or may
not want to use the same keywords for your social media site, depending on whether the product
and audience are the same for the website and social media site.
As a rule, more specific keywords are most effective. Many organizations use keyword phrases of
from two to four words, such as “dress shoes for women.” Another option is longer keyword
phrases, known as long-tail keywords. Studies show that over 35 percent of the time, the first link in
the list of results is the one that people click. Your site is more apt to be the first link or among the
first three links if you use long-tail keywords. However, a smaller group of searchers enter a given
long-tail keyword, so fewer people will then view the result of the search.
The right keyword selection is crucial to your campaign; be sure to thoroughly research your options
through sources such as Google AdWords, Trellian’s Keyword Discovery at
www.keyworddiscovery.com, and, of course, your customers. Determining the best possible
keywords is an art in itself, and deserves further study. Check if someone in your marketing
department has this expertise,consider hiring a search engine optimization (SEO) expert.

Guidelines for Planning a Social Media Campaign
Note: All of the Guidelines for this lesson are available as checklists from the Checklist tile on
the CHOICE Course screen.

As a starting point in planning your social media strategy, consider the following key guidelines.
• Start with your organization’s goals and overall marketing plan.
• Consider both long-term and short-term organizational goals.
• Evaluate which platforms lend themselves to your goals.
• Identify platforms that support content that your organization is already good at producing.

These may require less investment of time and energy.
• Evaluate which platforms are most popular in your target demographic.
• Before launching the campaign, select key performance indicators (KPIs) that match the goals.

In other words, decide on a method for measuring progress toward a goal.
• Design your campaign to be consistent with your organization’s brand in terms of logo, colors,

fonts, and language/verbiage.
• Select keywords to optimize search engine results; consider long-tail keywords.
• Use online keyword research tools.
• Think like your customer when selecting keywords: Choose words they would use in search

queries.
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ACTIVITY 6-1
Planning a Social Media Strategy

Scenario
Emerald Epicure sells a variety of olive oils. The largest share of purchases is made by well-educated
female consumers who have disposable income and an interest in cooking and nutrition. A smaller
share is sold to small restaurants. You have been asked to help form the company’s task force on
social media marketing.

1. Who should be on the social media planning team and why?
A: Possible answers include a representative from the organization’s strategic planning team, a

representative from marketing and sales teams, a representative from customer service, the web
designer, and the graphic artist.

2. Is there any additional information you need on your target audience?
A: Answers may vary, but may include age demographics, what proportion of buyers live in rural

versus urban areas, and more information on the small restaurants. The company might research
behaviors, lifestyles, and personality factors of current customers or desired customers. The
company might plan to target new market segments.

3. Visit one or more of the sites offering information on which demographics use which social media
platforms. Which platforms most closely match your target audience’s demographics?
A: Answers may vary. The Pew report in particular offers a wealth of information. Ragan offers a

condensed, easy-to-read version of the report, plus additional related articles. As of this manual's
publication date, the latest Pew repost lists Facebook as the most widely used platform and
Instagram as the second-largest population of women using a social network.

4. One of Emerald Epicure’s social media goals is to promote new products, specifically French olives
such as Niçoise and Picholine. List several options for keywords.
A: Answers may vary, but may include imported French olives, Niçoise olives, Picholine olives,

imported French Niçoise olives. Long-tail keywords have both advantages and disadvantages.
Further research may be advisable.
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5. Your colleague develops the following graphic to use on social media. The olives are green and the
words Emerald Epicure match the green shade of the olives, a different shade than your logo. How
effective do you think it might be? How would it fit into your marketing plan?
 

 
A: Answers will vary. The image does not use the colors of the website, and the company name is

rendered in a different font than in the website. The image does not include the logo. Therefore,
either the website or the image is not consistent with the company’s branding. Persons who have
visited the website and later see this graphic might wonder if the graphic is from a different
company of the same name.

6. If you decide to use the image, what revisions might you make to the ad?
A: Answers will vary. The company might consider adding the Emerald Epicure logo, rendering the

company name and perhaps the tag line in the brand color and font, or other changes to make the
ad more consistent with Emerald Epicure branding.

7. If you do post the ad, what platform would you use?
A: Answers will vary. A simple image of this type, with revisions, might be used as an ad on

Facebook or Pinterest. Other platforms may also be suitable.
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TOPIC B
Add Links to Social Media
As the mechanics of using social media vary from platform to platform, you may need to learn
procedures for several channels.

Facebook
Facebook, though not as dominant as it once was, remains the most popular social media channel.
The demographics of Facebook followers has changed, with an increase in middle-aged users and
perhaps a decrease in use by millennials. You can create a Facebook page for your organization and
buy advertising on Facebook.

Twitter
Twitter allows its users to send messages of up to 140 characters. A posting to Twitter is called a
tweet. Twitter users sign up to follow particular organizations or persons, or categories of tweet
sources. Twitter users can elect to have tweets emailed to them. You can place a feed of your tweets
on your website. You can partner with other organizations to place a feed of your tweets on their
sites.
Twitter claims 320 million active users per month, with 79 percent of accounts outside the United
States. Twitter supports over 35 languages. Pew Research Center reports that in 2016, 24 percent of
U.S. adults used Twitter. In the United States, users tend to be under 50 and college educated.
Although Twitter user demographics may differ in different countries, worldwide it is among the 10
largest social media networks.

Note: To learn more about linking to Twitter, check out the LearnTO Use Twitter in Your
Social Media Campaign presentation by clicking the LearnTO tile on your CHOICE Course
screen.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Add Links to Facebook.
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ACTIVITY 6-2
Adding a Link to Facebook

Data Files
All files in C:\092006Data\Marketing_Through_Social_Media_and_Email\starter

Before You Begin
Dreamweaver is open. All files are closed.

Scenario
You are nearly ready to post your new site for Emerald Epicure. Emerald Epicure already has a
Facebook page, and you want to be sure that your site visitors can "Like" your Facebook page and
"Share" it with their Facebook friends.

1. Use the files in C:\092006Data\Marketing_Through_Social_Media_and_Email\starter for the Emerald
Epicure site.
a) In the Files panel, select the Manage Sites drop-down list and select Manage Sites.
b) In the Manage Sites dialog box, select Emerald Epicure.

c) Select Edit site. 
d) Browse to C:\092006Data\Getting_Noticed_Through_Social_Media_and_Email_Marketing\starter.
e) Select Select Folder.
f) In the Site Setup dialog box, select Save.
g) If a box appears notifying you that the cache will be re-created, select OK.
h) In the Manage Sites dialog box, select Done.
i) Open the index.html page.

2. Create the code needed to insert a Like and Share link to Facebook.
a) In your preferred browser, navigate to https://developers.facebook.com/docs/plugins/like-button.
b) Select the Like Button Configurator button to jump down the page to that section.
c) In the URL to like text box, enter http://www.emeraldepicure.com
d) In the Width box, enter 255
e) From the Layout drop-down list, select standard.
f) In the Action Type drop-down list, select like.
g) Confirm that Include Share Button is selected.
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h) Select Get Code.
A window labeled "Your Plugin Code" appears
 

 

3. Paste the first box of code into your page.
a) Click in the code from the box under Step 2. It should be selected, but if not, right-click and select

Select all.
b) Right-click the selected code and select Copy.
c) In Dreamweaver, switch to the Code or Split view.
d) Paste just after the <body> tag.

4. Paste the second box of code into your page.
a) Return to the browser. If the code box is no longer displayed, select the Get Code.
b) Copy the code in the box below Step 3.
c) In Live view, select the Emerald Epicure logo image.
d) In the Insert panel, in the Bootstrap Components category, select Container.
e) In the Positioning pop-up, select After.
f) Switch to Split view.
g) In the Code portion of Split view, position the insertion point after <div class="container"> within the

new div tag.
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h) Paste your code.
 

 
The Facebook graphic will not be visible until you post your page to the server. We will not post the
page in this activity. When posted, your page would appear as follows.
 

 
i) Save and close index.html.
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TOPIC C
Create Email Marketing Materials and
Newsletters
You are reaching your customers, prospects, and organization members — whoever your target
audience is — through your website and now through selected social media channels. As you
develop your online marketing plan, you may need to use email to expand your market and keep the
attention of current customers.

Email Marketing Materials and Newsletters
Email can win you an additional boost in gaining your audience’s attention. As with the social media
campaign, coordinate your email with your marketing plan and use your organization's branding.
Provide links in the email to point back to more detailed information on your site or on social
media.
Email marketing can be used for occasional promotions or event notices, or regular newsletters. If
you are sending to large lists of external customers, consider using an email marketing service. The
services can provide you with assistance and templates in writing your email, help with managing
mailings and campaigns, marketing advice, and useful data on your customers’ email clients. Some of
the more popular email marketing services are Active Campaign, Campaign Monitor, Constant
Contact, Litmus, and MailChimp.
Designing materials for email requires markedly different coding from your web pages. Two major
differences involve layout methods and how to insert CSS. This is because email clients handle
HTML and CSS differently than browsers do. In some respects, you will take a step back in time to
methods more common in web design a few years ago.
In designing web pages, current best practice is to use div tags and HTML5 semantic tags to lay out
your page. However, in designing for email clients, use tables to lay out the page. Start with an outer
table to center all of your content in the email. Use an inner table to lay out images, text, and other
pieces of content in relation to each other. If your design calls for a background color, set the
background color for the outer table, as some email clients ignore formatting of the <body> tag.
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Figure 6-1: Use an outer table to center content.

Responsive Layout in HTML Emails
As more and more readers access their email on a smartphone or tablet, your HTML email should
be responsive. Major email marketing services often recommend a table layout with one column. In
the simplest case, each row contains only one cell.

Figure 6-2: Simple one-column table.
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You may wish to lay out several images or blocks of text horizontally and side-by-side for wider
viewports, but vertically for smaller viewports. Multiple cells within a table will not automatically
wrap. To achieve reliable wrapping, nest several one-cell tables inside your one-column table.

Figure 6-3: One-cell tables used for wrapping content in mobile viewports.

CSS in HTML Emails
When designing a website, it is most efficient to create your CSS in an external style sheet. However,
some email clients will ignore external style sheets and classes. Therefore, for HTML email, the CSS
should be entirely within the HTML page. Furthermore, with the exception noted below, the CSS
should be inline, not in a <style> tag, as some older email clients ignore the contents of a <style>
tag.
An exception to the rule about placing CSS inline is media calls. For the most part, mail clients on
smartphones and tablets will execute CSS in a style tag, so place your @media rule within a style tag.
CSS that is closest to the element it affects overrules CSS that is more distant. (This is the meaning
of "Cascading" in the term Cascading Style Sheets.) Therefore, an inline style will overrule an
@media rule in the style tag. Fortunately the !important rule can ensure that the CSS in an
@media rule control is displayed in specified viewports. As an example, for viewports no wider
than 480px, the following code will display any table at a width of 100 percent of the table’s
container, with no border, even if inline CSS specifies a lesser width or defines a border. This code
is included in the Dreamweaver email template.
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Some email clients ignore certain CSS properties, regardless of where they are placed. A notable
example for layout purposes is the clear property. In writing web pages, it is very common to use
the clear property to clear out float properties. In HTML email, consider using <br> to place one
element below another instead of using clear. Some email clients also ignore CSS for rounded
corners and background colors.

Guidelines for Writing Marketing Email and Newsletters
When writing marketing HTML email and HTML newsletters, consider the following guidelines.
• Research your readers: Learn which email clients your readers will be using. Are your readers

internal to your company? If your readers are external customers and you are using an email
marketing service, after you have sent email to your customer list, ask the service for a report on
which email client your customers use.

• Make the email responsive.
• Use tables for layout and nested one-cell tables to achieve horizontally laid-out content in wide

viewports and vertically laid-out content in narrow viewports.
• Be aware that some email clients block images until the reader clicks a button. Many readers

won’t click this button. Be sure crucial information is visible in text even if it is repeated in
images. You can place crucial information in the alt tags for images, although not all email clients
will display alt text.

• Use inline CSS; place your media queries in the body, not in the head. Consider using an
“inliner” tool that will take a style from an external style sheet or from a <style> tag in a page
head and apply it to each corresponding element. If you are using an email marketing service, the
service may provide you with an inliner tool. Inliner tools are also available from other sources.

• Some email clients can’t render a background color or a rounded corner border. Ensure that
your design will appear functional and attractive without these.

• Some email clients ignore the CSS clear rule. Use line breaks <br> to arrange one element below
another.

• Avoid hover states for links.
• Avoid JavaScript or other scripts.
• Avoid Flash.
• In linking to web pages, use absolute URLs, meaning the entire address. For example, use

http://www.emeraldepicure.com/newproducts.html instead of newproducts.html.
• If you want readers to complete a form, link to the form on your website.
• Validate your code. Dreamweaver can be used to connect to the W3C code validator.
• Test in Outlook and other popular email clients. You should also test on a variety of phones and

tablets. Your email marketing service may well offer a tool for testing in a variety of email clients.
If you have not yet selected an email marketing provider, choose one that will provide a broad
testing tool.

104  |  Adobe® Dreamweaver® CC (2017): Part 2

Lesson 6: Marketing Through Social Media and Email  |  Topic C

Guidelines for Writing
HTML Email

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



• Once you have an email layout and format you like, use it as a template for future
correspondence.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Create Email Marketing Materials and Newsletters.
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ACTIVITY 6-3
Creating Email Marketing Materials

Data Files
Continue with files from previous activity.

Before You Begin
Dreamweaver is open. The Emerald Epicure site is still set to C:\092006Data
\Marketing_Through_Social_Media_and_Email\starter.

Scenario
You have been asked to create an HTML email message featuring two types of French olives. Your
company will be using a popular email marketing service to distribute the message. Because you
have limited time, you decide to use the responsive email template built into Dreamweaver.

1. Create an HTML file for using Dreamweaver's built-in email template.
a) Select File→New.

The New Document dialog box opens.
b) At the left of the New Document dialog box, select Starter Templates.
c) Under Sample Folder, select Email Templates.
d) Under Sample page, select Email - Responsive.

 

 
e) Select Create. A new file appears.

2. Observe and save the file.
a) In Split view, observe the placeholders for images and text. In the code section, scroll through the

code and notice that tables are used for the page layout.
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b) Select the large image placeholder labeled 576 × 250. Observe the Tag Selector.
c) Select File→Save. Name the file NewProductsEmail.html

3. Insert header content.
a) In Live view, select LOGO. Observe that the word Logo is contained in a <td> tag.
b) Select the Insert panel and, in the HTML category, select Image.
c) In the positioning pop-up, select Nest.

The Select Image Source dialog box appears.
d) Navigate to Marketing_Through_Social_Media_and_Email\starter\images and select logo_small.png.

Select OK.
e) Delete the text LOGO.
f) Select Issue |Date and enter today’s date.
g) In the Files panel, expand the images folder.
h) In the Document window, select the image placeholder labeled 576 × 250.

i) In the Properties Inspector, select the Src Point to File  tool and drag to Files panel→images
folder→file: inner_banner_small.png.

4. Insert the heading text and slogan.
a) Replace the words EMAIL THEME with Monthly Feature: French Olives
b) Replace the words SOME AWESOME TAG LINE with Olives: Great taste, great health

5. Delete a table row to remove a large block of text.
a) Select the placeholder text below your new tag line. Observe that the text is contained in a <td> tag.
b) Use the Tag Selector to select the last <tr> tag that contains the <td> tag.

 

 
c) Press Delete to delete the <tr>.

6. Delete the first two small images and associated text.
a) Observe the grid of four image placeholders. Select the text just below the first image placeholder.
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b) In the Tag Selector, notice that there are several nested tables. Select the <table> tag with the
class .responsive-table.
 

 
Observe that this table contains an image placeholder and the placeholder text.
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c) Now select the <tr> that contains your previous selection and column beside it. Two link buttons will
also be contained in this table row.
 

 
 

 
d) Press Delete. Instead of two rows of image placeholders with text and links, now there is only one

row.

7. Add promotional content to nested tables.
a) Select the first image placeholder in the promotional content segment. In the Properties Inspector,

drag from the Src Point to File tool  to the Files panel images folder, file salads_Nicoise.jpg.
b) Select the sample text under the first image. Selecting this text will select a <p> tag. Replace the

selected text with Classic Nicoise Olives
c) Click outside the text.
d) Select the text Read More under the first image. In the text box, delete the #

 

 
e) In the link box that displays above the text, add a link to http://www.emeraldepicure.com/

newproducts.html
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f) Select the second placeholder image in the first row. In the Properties Inspector, drag from the Src

Point to File tool  to the File panel images folder, file picholine_olives.jpg.
g) Select sample text under the second image. Replace the placeholder text with Crunchy Picholine
h) Select the text Read More under the second image. As you did for the first product, set the link

destination to http://www.emeraldepicure.com/newproducts.html
i) Press F5 to refresh the Live view.
j) Save the file and keep it open.
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ACTIVITY 6-4
Styling Email Marketing Materials

Data Files
Continue with files from previous activity.

Before You Begin
Dreamweaver is open. The Emerald Epicure site is still set to C:\092006Data
\Marketing_Through_Social_Media_and_Email\starter. The file NewProductsEmail.html
is open.

Scenario
You have created an HTML email. You decide to refine the style of several email elements.

1. Style the product names in promotional section of the page by using inline styles.
a) Switch to Split view.
b) In the Live portion of your page, select <p> Classic Nicoise Olives.
c) Observe that the code corresponding to this text is selected in the code portion of the page. Observe

the inline style assigned to the paragraph.
 

 
d) Set font-weight to bold and the color to # 5E5C5D. This will render a darker shade of gray.

 

 
e) Edit the <p> containing the words Crunchy Picholine in the same way.
f) Refresh Live view.
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2. Style the Read More button to be slightly narrower in smaller viewports by editing the @Media rule.
a) In the Visual Media Queries bar, select the 600px media rule. Observe that the Read More buttons

extend almost all the way across the available space.
b) In the Live portion of Split view, select the Read More <p> for the Classic Niçoise Olives.
c) In the Code portion of the Split view, observe the selected code. Within the selection, add to the <p>

tag attributes: id=”productlink1”
 

 
d) In the Live portion of Split view, select the Read More button for the Crunchy Picholine Olives.
e) In the Code portion of the Split view, observe the selected code. Within the selection, add to the <p>

tag attributes: id=”productlink2”
f) Still in the Code portion of Split view, scroll upward to the @Media screen and (max-width:600px)

rule.

Note: This should be at or near line 26 in the code.

g) After the last style in this @Media rule, add the following code. Be sure to enter the closing } so that
the } that closes the @Media rule will not be lost.
 

 
h) Switch to Live view.
i) Refresh Live view.
j) In the Visual Media Queries bar, make sure that the 600px media rule is selected. Observe that the

Read More buttons are now slightly narrower.

3. Observe code and close.
a) Switch to Code view. Observe that both the HTML and the CSS are in the same file.
b) Save the file.
c) Close all the files.
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Summary
In this lesson, you examined the process of planning a social media campaign and created a "Like"
button for Facebook. In addition, you created and styled an HTML email message for an email
campaign.

If your organization uses social media or may do so in the future, which platform do you think would be
most beneficial?

A: Answers will vary, and might include how a given platform is right for the organization's goals and
target audience.

If you are not sure which platform your target audience uses, how would you find out?

A: Answers will vary, and might include websites that provide statistics on demographics of social media
users, and asking members of the target audience.

Note: Check your CHOICE Course screen for opportunities to interact with your classmates,
peers, and the larger CHOICE online community about the topics covered in this course or
other topics you are interested in. From the Course screen you can also access available
resources for a more continuous learning experience.
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Testing and Maintaining
Your Site
Lesson Time: 30 minutes

Lesson Introduction
The different tools and features available in Adobe® Dreamweaver® CC have enabled you
to develop a fully functional and interactive website. Consider what would happen if the
website isn't displayed as intended (as in a different browser or device than it was tested on)
or some of the navigational elements do not work as planned. Your users might experience
errors in planned functionality or might find the navigation or content confusing. All your
time and effort could be in vain if you do not take proactive measures, such as usability
testing and validation, to ensure that your website works as you intended when it is rolled
out to end users.
As you develop the website, there will be times when you might require multiple developers
to work on it. Sharing website files with others on your team enables you to work on the
website-related files in a collaborative manner and complete tasks quickly. Adobe
Dreamweaver CC provides you with features that help you track, manage, and synchronize
your files effectively when working in a collaborative environment.

Lesson Objectives
In this lesson, you will:

• Optimize appearance and actions on your site by validating against World Wide Web
Consortium standards

• Share website files with other users.

• Synchronize local and remote copies of your site while coordinating with other authors.

7
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TOPIC A
Validate Your Site Against W3 Standards
A lot of time, effort, and creativity are spent in the process of developing a website. All the effort
will be wasted if users encounter various problems while accessing the site. However, before the site
is uploaded to a server, it should be tested to ensure that the website is displayed and functions as it
is supposed to. In this topic, you will test a website.

Storyboard Testing
Before a website is built, the entire site is commonly represented by a storyboard. The storyboard
serves as reference material at any instance during the site's development. Once the site is
completed, it needs to be tested against its storyboard. This ensures that all the objectives that the
site was built to meet are achieved. During storyboard testing, all the details that are represented on
the storyboard, such as website hierarchy, file name, page or document name, navigation, images,
text, and link information, will have to be checked. Other details include the assets used on the site,
navigation structure, user interaction components, and site validation requirements.

World Wide Web Consortium Standards and Validation
The World Wide Web Consortium (W3C) sets standards for HTML and CSS. If code does not
comply with W3C standards, there is an increased chance that the page will not appear or function
properly in some browsers. To a certain extent, some, but not all, web browsers tend to be
"forgiving" of certain common coding errors. Thus, you might write a page that contains syntax
errors and therefore does not comply with these standards. When you test that page in one or two
browsers, the page may be displayed as you intended. However, when some of your users display
the page in a browser you didn't test, your users may be the first to experience a malfunctioning,
unreadable, or unattractive result.
W3C validation checks whether or not HTML and CSS on a given page comply with those
standards. The purpose of validation is so that users do not have issues when browsing a website.
The World Wide Web Consortium, w3.org, offers several validation tools.
• Markup validation for HTML: The markup validation tool checks the HTML code against syntax

(that is, the grammar) of HTML. This tool is available at https://validator.w3.org. You can
validate your page by using your browser to navigate to this URL, or you can open your file in
Dreamweaver and select File→Validate→Validate Current Document (W3C).

• Markup validation for CSS: This markup validation tool checks the CSS style sheet code against
the syntax of CSS. This tool is available at http://jigsaw.w3.org/css-validator.

• Broken link checker: Little is more frustrating than finding a promising link, following it, and
then learning that the anticipated page no longer exists. Broken links can not only frustrate your
visitors, but also reduce their confidence in your site. W3C offers a link checker at https://
validator.w3.org/checklink. Dreamweaver CC (2017) also offers a method for checking links.

Be aware that even after your pages pass validation testing, some browsers may render the page in a
way you didn't intend. Validation reduces, but does not completely eliminate, possible display
problems.

Usability Testing
The goal of usability testing, as applied to websites, is to ascertain how easily and effectively visitors
can use the website. Typically paid or unpaid representatives of the expected user group are invited
to test the site. Usability testing should be completed before uploading to a production server; that
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is, before making the site available to the public or to its intended users within an organization.
Usability testing can be planned and executed by in-house staff or outsourced to usability testing
consultants.

Elements Involved in Conducting a Website Usability Test
The first step in the process of performing a website usability test is to draw up a usability testing
plan. This plan details the purpose and goals of the usability test and includes the parameters against
which the results will be measured. Examples of goals include:
• Relevance of content to the target audience.
• Ease of navigation.
• Consistency in the layout and presentation.
• Success in accomplishing a task such as filling up a form or completing an online shopping

transaction.
Target audience representatives performing the test can be provided with checklists to ensure that
all the parameters are tested.
The end task in this process is to compile the information from the testers, analyze it, and identify
any necessary changes. Collecting information from the testers can be done through different
methods, such as:
• Videotaping or audio recording the sessions
• Observing the tester while the testing is in process
• Interviewing the tester after the testing process
• Asking the testers to provide their feedback in a questionnaire or form
Final results obtained out of the website usability test should be used to take remedial actions, if
necessary.

Other Feedback Before and After Posting
In addition to gathering feedback during structured usability testing, it can be helpful to elicit
feedback from other stakeholders. Invite colleagues within the company to visit the test site and
email their feedback. If you wish to secure feedback from trusted stakeholders outside your
organization, consider arranging access in a secure manner and inviting comment. Finally, after the
site is posted, your site should offer a feedback form or, at the least, an email link for providing
feedback in an ongoing manner.
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Figure 7-1: Feedback from varied sources.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Validate Your Site Against W3 Standards.
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ACTIVITY 7-1
Validating Your Site Against W3C Standards

Data Files
All files in C:\092006Data\Testing_and_Maintaining_Your_Site\starter

Before You Begin
Dreamweaver is open. All files are closed.

Scenario
Before you upload your website on the server, you would like to test and validate the site to detect
and correct errors.

1. Use the files in the folder C:\092006Data\Testing_and_Maintaining_Your_Site\starter for the Emerald
Epicure site.
a) In the Files panel, select the Manage Sites drop-down list and select Manage Sites.
b) In the Manage Sites dialog box, select Emerald Epicure.

c) Select Edit site. 
d) Browse to C:\092006Data\Testing_and_Maintaining_Your_Site\starter.
e) Select Select Folder.
f) In the Site Setup dialog box, select Save.
g) If a box appears notifying you that the cache will be re-created, select OK.
h) In the Manage Sites dialog box, select Done.

2. Open history.html.

3. What are some of the details listed in a storyboard? (Choose four.)
☐  Assets used on the site
☐  Navigation structure
☐  User interaction components
☐  Site validation requirements
☐  Project plan
☐  Coding standards

4. Which test will you perform on the site to ensure that all the objectives that the site was built to meet are
achieved?
○  W3C validation
○  Usability
○  Storyboard
○  Site report

5. True or False? The participants in the usability test are members of the team that developed the site.
☐  True
☐  False
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6. Validate the history.html page.
a) Select File→Validate→Current Document (W3C).
b) If the W3C Validator Notification dialog box appears, select OK.

If Don't show this dialog again has been selected in the past, the W3C Validator Notification dialog
box will not appear. Either way, the Validation panel will appear listing any errors. The validation
results for the history page will be:
 

 
c) Observe errors listed. Observe that the line number of the error is specified. Two images are

missing an alt attribute. Line 99 contains a stray div tag.
d) Note: You will not be using this file again, so there is no need to correct the

errors at this point.

Close the Validation panel.
e) Close history.html.
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TOPIC B
Share Website Files with Other Users
Chances are that you may not be the only person to work on a website development project. With
crunched deadlines and fast turnaround times, you may need to work with a team, which requires
sharing your website-related files with multiple users. Transferring the files to a server will help you
accomplish this. In this topic, you will share your website files with other users.

SSL
The Secure Socket Layer (SSL) protocol is used to provide extra security when communicating across
multiple networks. Sensitive information that is transferred on a network (such as the Internet) is
encrypted, thereby ensuring the integrity of data. It is mostly used in websites where confidential
information is obtained from customers. For example, shopping carts for e-commerce sites use SSL.
When the user enters HTTPS: in the browser URL box, the browser and server negotiate an
encrypted session based on the key from the server's SSL certificate, and a temporary key the
browser generates for that particular session.

Note: The SSL protocol has been superseded by Transport Layer Security (TLS), though most
websites and browsers support either. Web hosting companies and others often describe their
encrypted transmission as SSL, the term that is more familiar to many, even when the protocol
used is TLS.

In addition to providing encryption, an SSL certificate can prove the site's identity to a website
visitor. After all, users want to be sure that they are actually connected to their favorite online store
and not an imposter site set up by a hacker.
A website with an SSL certificate displays HTTPS: in the browser URL box. Many, if not most,
website users know that HTTPS provides extra security.
If you are managing a site or authoring portions of a site, you want to rest assured that only
authorized developers are uploading files to the website. To accomplish this goal, the server
administrator can configure the remote site to require a connection that encrypts both the login
information and the data transmitted. If that is the case, you will need to configure your
Dreamweaver site connection type for the right protocol. Dreamweaver CC supports a number of
encryption options, including using SSL. Request the protocol and port number information from
your server administrator.
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Figure 7-2: Site setup connection types.

Note: SFTP, or Secure FTP, is an extension of Secure Shell (SSH). It is a popular choice for
encrypting FTP connections.

In high security environments, the client might also be required to furnish an SSL certificate to
prove its identity to the server. This is usually done for virtual private network (VPN) connections
and not FTP or web servers. However, some organizations might require it. If this is the case, the
client certificate would be installed in the client operating system, and not in Dreamweaver.

Note: For more information on configuring remote connections, see the article "Connect to a
remote server" at http://helpx.adobe.com/dreamweaver/using/connect-remote-
server.html.

Check-Out Feature
Dreamweaver’s file check-out feature allows you to prevent multiple developers from editing the same
file simultaneously. This is beneficial when working in a collaborative environment where many
team members need to work with the same file. You can identify which files are checked out from
the Files panel. If someone other than you checked out the file, a red check mark will be displayed
for each checked out file, along with the name of the person who checked out the file. A green
check mark next to the file’s icon indicates a file that you checked out.
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Figure 7-3: The checkmark indicates a checked-out file.

Dependent Files
When you share web pages between the local root folder and a remote folder by using the Files
panel, you are notified to upload dependent files or download dependent files of a page. Dependent
files are the images, external style sheets, library items, and other files that are referenced on the web
page and that are loaded by the browser when the web page is loaded. It's recommended to
download these dependent files during check-out and upload them during check-in. If the latest
versions of the dependent files are already available in the local folder, you need not download them
again. Similarly, if the latest versions of the dependent files are already available in the remote folder,
you need not upload them again.
To refrain from uploading or downloading dependent files, set the options in the Dependent files
section by selecting Edit→Preferences→Site.

Check-In Feature
Dreamweaver’s file check-in feature enables you to transfer an edited file back onto the server so that it
is available to other team members for editing. After you check-in a file, the local version of the file
becomes read-only, and a Lock icon is displayed next to the file in the Files panel, indicating that
the file cannot be edited.

Adobe® Dreamweaver® CC (2017): Part 2  |  123

Lesson 7: Testing and Maintaining Your Site  |  Topic B

Check-In Feature

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



Figure 7-4: The lock icons indicate checked-in files.

Cloaking
In using Dreamweaver CC, you will at times be performing certain operations on the entire site as a
whole. You may wish to get or put the entire site, or check all links, or generate reports. If you need
to perform a site-wide operation and yet wish to exclude certain files, the cloaking feature will allow
you to do so. For example, you might want to store files that need to be updated in the local site and
upload them onto the server only when finalized. Or, you might maintain a subfolder as part of the
local root folder that contains files you will never post, such as PSD files, for example. By default,
you can apply cloaking to selected files and folders in any site. It is possible to disable this feature.
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Figure 7-5: The cloaked files listed in the Files panel.

Cloaking prevents cloaked files and folders from being part of certain operations, such as:
• Check-in, check-out, get, and put
• Synchronization
• Finding newer local and remote documents
• Working with contents in the Assets panel
• Updating available templates and libraries
• Generating reports
• Site-wide operations–checking and changing links
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ACTIVITY 7-2
Sharing Website Files with Other Users

Data Files
All files in C:\092006Data\Testing_and_Maintaining_Your_Site\starter

Before You Begin
Dreamweaver is open. All files are closed.

Scenario
You are almost done with the development of a website for Emerald Epicure. But there are some
last-minute tasks that need to be completed in a very short timespan. You decide to share your
website files so that multiple developers can work on them.

1. Note: The EE_ Test_ Server folder represents a remote server, but located within
the local machine. The steps given here simulate the actual file transfer to and
from a remote server.

On the C drive, create a folder with the name EE_Test_Server

2. Set up a server.
a) In the Files panel, from the Site drop-down list, select Manage Sites.
b) In the Manage Sites dialog box, in the Your Sites section, verify that Emerald Epicure is selected.

Select the Edit the currently selected site button. 
c) In the Site Setup for Emerald Epicure dialog box, in the left pane, select Servers.

d) Select the Add new Server button. 
e) On the Basic tab, in the Server Name text box, type EE Test Server
f) From the Connect using drop-down list, select Local/Network.

g) To the right of the Server Folder text box, select the Browse button. 
h) In the Choose Folder dialog box, navigate to C:\EE_Test_Server and select Select Folder.
i) Select Save to add the server.
j) In the Site Setup for Emerald Epicure dialog box, select Save.
k) In the Manage Sites dialog box, select Done.

3. Cloak the files that have the .psd extension.
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a) In the Files panel options menu, select Site→Cloaking→Settings.
 

 
b) In the Site Setup for Emerald Epicure dialog box, if necessary, expand the Advanced Settings tab

and, in the Cloaking section, check the Cloak files ending with check box.
c) Observe that the default is to cloak files that have .fla and .psd extensions.

 

 
d) Accept the default and select Save.
e) Observe that the Dreamweaver message box displays a message that the cache will be re-created.

Select OK.
f) In the Local Files pane, expand the images folder.
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g) Observe that a red slash appears to the left of the files that have the .png extension, indicating that
the files have been cloaked.
 

 
h) Collapse the images folder.

4. Place the site files on the server.

a) On the Files panel toolbar, select the Expand to show local and remote sites button. 

b) On the toolbar, select the Connect to Remote Server button  to connect to the remote server.
c) Make sure that the Remote Site pane displays C:\EE_Test_Server\
d) In the Local Files pane, select the Site root folder if it is not already selected.

e) On the toolbar, select the Put File(s) button  to upload the site files to the server.
f) Select OK to confirm uploading the entire site to the remote server.
g) Observe that the Remote Site pane displays the files uploaded to the server.

5. Enable check out.
a) In the Files panel, from the Site drop-down list, select Manage Sites.
b) In the Manage Sites dialog box, verify that Emerald Epicure is selected and select the Edit button.
c) In the Site Setup for Emerald Epicure dialog box, in the left pane, select Servers and select EE Test

Server.

d) Select Edit existing Server  and select the Advanced tab.
e) On the Advanced tab, in the Remote Server section, check the Enable file check-out check box.
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f) In the Check-out Name text box, type Student
 

 
g) Select Save.
h) In the Site Setup for Emerald Epicure dialog box, select Save.
i) In the Manage Sites dialog box, select Done.

6. Check in all the files onto the server.

a) In the Local Files pane, select the site root folder. On the toolbar, select the Check In button. 
b) Select OK to check in the entire site.
c) In the Local Files pane, observe that a lock symbol appears to the left of the files, indicating that

they are in read-only mode.
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7. Check out the harvest.html file from the server.
a) In the Local Files pane, select the harvest.html file.
b) Right-click harvest.html and select Unlock.
c) Right-click the file again and select Check Out.
d) In the Dependent Files message box, select Yes.
e) Observe that a check mark appears to the left of the harvest.html file, indicating that it is now ready

to be edited. In the Remote Server pane.
 

 
f) Right-click the words Local Files and, from the menu, select Checked Out By to display the column.

Notice that in both the Remote Server and Local Files lists that the Checked Out By column is now
displayed and that Student is shown as the person who checked out the harvest.html file.

8. Edit the file and check it back in.
a) Open harvest.html.
b) In Code view, on line 96, enter the word The in front of the first sentence of the first paragraph in the

body, and set the H in "Harvesting" as lowercase.
 

 
c) Select File→Save.

d) In the Files panel, select the Check In button. 
e) If Dreamweaver prompts you with a message, select Yes to check in the file.
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f) In the Local Files pane, observe that a lock symbol appears to the left of harvest.html, indicating that
it is once again in read-only mode.

9. Leave all files open.
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TOPIC C
Synchronize Your Site
You have tested your site and posted it to a testing server or to a live server, which displays it to
your colleagues or the Internet. You and perhaps others make periodic updates. You need to know
which files are more recent: those on the remote server or those in your local workings folders.

Site Synchronization
Synchronization is a feature in Dreamweaver that enables you to compare the local versions of your
documents with the remote versions, to ensure that you are using updated documents. In the
Synchronize Files dialog box, you can specify the files or sites to be synchronized and the direction
in which synchronization should take place. After synchronization is complete, Dreamweaver
confirms the files that have been updated.

Figure 7-6: The synchronization process.

Synchronization Direction
Three options are available from the Synchronize with Remote Server dialog box to specify the
direction in which you want your files to be copied.
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Option Description

Put Newer Files To Remote Uploads new files or updated files present in the local site onto
the remote server.

Get Newer Files From Remote Downloads new files or modified files available on the remote
server onto the local site.

Get And Put Newer Files Places the recent versions of all the files on the local site and
remote server.

Figure 7-7: The Synchronize with Remote Server dialog box allows you to choose direction.

File Comparison
Dreamweaver allows you to compare files present in the local site and remote server by using file
comparison tools. You can compare code of two local files, two remote files, or the local and
remote versions of the same file. File comparison tools cannot be used to compare movie files or
graphics. Before you compare two files, you need to install a comparison tool on your system.
Dreamweaver mostly works with third-party file comparison tools. Some third-party comparison
tools that are compatible with Dreamweaver are WinMerge and Notepad++.

Access the Checklist tile on your CHOICE Course screen for reference information and
job aids on How to Synchronize Your Site.
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ACTIVITY 7-3
Synchronizing Your Site

Data Files
All files in C:\092006Data\Testing_and_Maintaining_Your_Site\starter
C:\092006Data\Testing_and_Maintaining_Your_Site\Additional files\oliveoils.html

Before You Begin
You are still connected to the remote server and the harvest.html file is open.

Scenario
A website developer wants to add a new web page to a site. He needs to ensure that once the file is
added to the local system, the same addition needs to be mirrored in the server copy.

1. Copy a newly created file onto the site folder.
a) In File Explorer, navigate to the C:\092006Data\Test_and_Validate_Your_Site\Additional_Files folder

and copy the oliveoils.html file.
b) Navigate to C:\092006Data\Test_and_Validate_Your_Site\ starter and paste the oliveoils.html file.
c) If the file does not automatically appear inn the Dreamweaver application, at the bottom of the Files

panel, select the Refresh button. 

2. Synchronize the newly created file on the site folder with files on the remote site.

a) On the toolbar, select the Synchronize with "Remote Server" button. 
b) In the Synchronize with Remote Server dialog box, from the Synchronize drop-down list, verify that

Entire 'Emerald Epicure' Site is selected.
c) In the Direction drop-down list, select the Put newer files to remote option.

 

 
d) Ensure that the Delete local files not on remote server check box is unchecked.
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e) Select Preview. In the Synchronize dialog box, observe that one file, oliveproducts.html, will be
updated.
 

 
f) Select OK to place the file onto the server. Observe that the uploaded file is displayed as being in a

checked-out state.

Note: If Dreamweaver displays a message warning that there is no remote
copy of the file, select OK and try again.

3. Check in the file onto the server.
a) In the Local Files pane, select oliveoils.html.
b) On the toolbar, select the Check In button.
c) If necessary, in the Dependent Files dialog box, select Yes.
d) Observe that a lock appears to the left of the file, indicating that it is now in read-only mode.
e) Close any open files and close the Adobe Dreamweaver CC application.
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Summary
In this lesson, you validated your site code by using the W3C evaluation tool, set up a system of
checking files in and out, and synchronized your site with a remote server.

What kinds of problems could arise from not establishing a system of checking in and out when you have
multiple authors?

A: Answers will vary. If two authors work on a file at the same time, their changes might conflict. Two
authors might waste time by both drafting the same update at the same time.

How might you go about testing your site for usability?

A: Answers will vary and may include hiring representatives of the target audience, recruiting volunteers
from the target audience, or subcontracting this task to contractors.

Note: Check your CHOICE Course screen for opportunities to interact with your classmates,
peers, and the larger CHOICE online community about the topics covered in this course or
other topics you are interested in. From the Course screen you can also access available
resources for a more continuous learning experience.
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Setting Project
Requirements
Lesson Time: 30 minutes

Lesson Introduction
When using Adobe® Dreamweaver® CC, it is important to know how to plan and execute a
project. You must understand the requirements and specifications of your project, so you
will know what actions you need to perform, the environment you are designing for, the
expectations for the final product, and who your end user is. Knowing this information up
front will make your projects run more efficiently.
Everyone practices project management to some degree. For example, making dinner
requires plans, such as recipes. You must secure assets with a trip to the store, and it is a
good idea to have a budget to make sure everything is affordable. Certainly the objective is
to eat, but who is the dinner for? Meatloaf and green beans might be your family's favorite
but impressing your boss might require filet mignon and grilled asparagus. You will need to
prepare each part of the dinner at the correct time, so everything ends up on the table
together. What tasks can you delegate? If you are an especially good project manager, you
might have the kids set the table and your spouse chop onions.
Project management is vital to the business world. A well-planned and efficiently run project
keeps costs in line, sticks to the timeline, utilizes resources effectively, minimizes unpleasant
surprises, and delivers a product or service that provides the company with a high return on
investment.

Lesson Objectives
In this lesson, you will:

• Establish project requirements and documentation.

• Identify and adhere to established copyright rules.

• Determine project management tasks.

8
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TOPIC A
Identify Purpose, Audience, Audience Needs
As an Adobe Dreamweaver site designer and web page developer, you will need to have a solid
understanding of the purpose and audience for site content. You will need to identify project
requirements, client goals, audience needs, and common problems that arise throughout the project
development cycles.
In this topic, you will learn how to identify client requirements and project goals, and examine
project documentation to see how the project requirements documents compare to the finished
project.

Purpose
When determining the purpose of the content, it is necessary to consider the client's goals for the
project and identify how the content can best fulfill those goals. Is the purpose to educate, entertain,
or inform? What types of text, media, functionality, and interactivity will be needed?

Audience
As you identify how the content should be communicated, it is important to consider the
demographics of the target audience. Key demographics generally include age group, gender,
computer literacy, education, income level, and geographical location. How relevant the
demographics will be to a project will vary from project to project.

Audience Needs
What does your audience expect to gain from the experience, and how can you best meet their
needs? Consider usability, accessibility, engagement, and the technology the audience will be using to
determine how audience needs can best be met.

Guidelines for Identifying Purpose, Audience, and Audience
Needs
Follow these guidelines to identify project purpose, audience, and audience needs.

Note: Access the Checklist tile on the CHOICE Course screen to view all the Guidelines for
this lesson.

Determine the Project Purpose and Objectives
To determine a project's purpose and objectives, consider the following:
• What should be the final outcome of the project? For example, is it a call to action, such as

prompting donations for a nonprofit organization? Or is it informational, such as an
instructional video or pamphlet?

Identify Who Your Audience Is
To determine your audience, identify:
• Age range
• Gender
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• Education level
• Socioeconomic class
• Geographic location

Determine Your Audience Needs
To identify your audience's needs:
• If you are designing for a specific audience, what would appeal to them?
• What challenges or constraints are they facing? For instance, if you are designing for college

students, you would realize that the majority of college students face financial burdens.
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ACTIVITY 8-1
Determining Your Target Audience

Data Files
C:\092006Data\Setting Project Requirements\chocolates.png
C:\092006Data\Setting Project Requirements\flyer.png
C:\092006Data\Setting Project Requirements\zoo.png
C:\092006Data\Setting Project Requirements\billboard.png
C:\092006Data\Setting Project Requirements\business_card.png

Scenario
Most design projects are created with the target audience in mind, the designer implementing design
elements specific to the demographics within that audience. Examine the following files and
determine the target audience for each one of them. This is an open discussion. There are no right
or wrong answers. Be sure to share your opinion, especially if it is different from others. You may
have experiences or a different perspective that can bring value add to the conversation.

1. Open C:\092014Data\Setting Project Requirements\chocolates.png and answer the following questions.
 

 

What is the target audience demographic, such as age, gender, profession, and so on?
A: Answers will vary. Some will say that the adult professional woman is the target. Others might

expand the gender to both sexes, or place the age at mid-30s–50s.

2. In what type of environment would the product be most successful?
A: Answers will vary. Some will suggest that an upscale boutique shop would be an excellent venue.

Others might say online or in a coffee shop.
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3. Is the finished design effective in reaching its target audience?
A: Answers will vary, but the consensus will probably be yes.

4. Open the website ww5.komen.org and answer the following questions.

What is the target audience?
A: Answers will vary. Some will say women of all demographic types and ages. Others will say it also

includes men. Still others will say anyone who is concerned with finding a cure for breast cancer.

5. What is the objective of the website?
A: Answers will vary. Some will point to the fund-raising aspect. Others will highlight the informational

aspect or the effort at building a community.

6. Open the C:\092014Data\Setting Project Requirements\zoo.png file and answer the following questions.
 

 

What is the target audience?
A: Answers will vary. Some will say the parents of kids. Others will say the kids themselves.

7. Which elements present in the design lead you to that conclusion?
A: Answers will vary. Those who say the target is parents will point out that the phone number and

web address point to an older audience. Others will say the headline of feeding a giraffe would be
especially exciting to children.
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8. Open the C:\092014Data\Setting Project Requirements\billboard.png file and answer the following
questions.
 

 

What is the target audience?
A: Answers will vary. Most will say women in their 20s and 30s.

9. Given the client, is this an effective way to advertise their product?
A: Answers will vary. Some students may remember seeing advertising by GAP NOW. People will

have different opinions about the effectiveness of this approach. Some will say that it suggests
that the target audience wants to differentiate themselves from past generations and, therefore,
the approach is effective.

10. Is it evident that this is an attempt at reaching a new demographic?
A: Answers will vary. Some will point out that the color and makeup of the subjects on the left make

the images look older, more artificial, and dated (That was then...). The "This is now." images are
brighter in color, more vibrant, closer, and more intimate. Some will say it is a new demographic
(generation). Others will say it's the same demographic that is re-inventing itself culturally.

11. Open the C:\092014Data\Setting Project Requirements\business_card.png file and answer the following
questions.
 

 

What is the target audience?
A: Answers will vary, but many will say a slightly younger crowd looking for "edgier" tattoo designs.

12. Which elements present in the design lead you to that conclusion?
A: Answers will vary. The designs are atypical, with more unusual colors. The background is black,

which suggests a younger crowd.

142  |  Adobe® Dreamweaver® CC (2017): Part 2

Lesson 8: Setting Project Requirements  |  Topic A

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



13. What about this particular design makes it somewhat different from the previous designs?
A: Answers will vary. The images are "darker" in emotional tone and more fanciful and fantasy-

oriented.
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TOPIC B
Adhere to Copyright Rules for Site Content
Copyright law, developed to protect intellectual property, was enacted to enable our society to
progress. Because you create original work when you build web pages and you might use graphics,
illustrations, and text created by others in building those pages, you are on both sides of the
copyright law. As a graphic designer, you seek both protection for your intellectual property and fair
and legal use of the intellectual property of others.

Copyright Terminology
All products resulting from human creativity are considered intellectual property. A copyright is
protection of a specific and tangible expression of an idea. It does not protect the idea. That
expression can take the form of a novel, song, design, movie, website, and so on. A trademark is
similar but it protects a design, image, slogan, symbol, or word that identifies goods or services. The
copyright owner obtains the copyright at the moment of realization or completion of the tangible
result from the idea.

Available Permissions for Use
One limitation to the copyright law is for fair use. Fair use allows limited use of a copyright-
protected work. What is allowable is determined by the following factors:
• The purpose of the use.
• The nature of the copyright-protected work.
• How much is to be copied.
• The effect on the market or value of the work.
Fair use is determined on a case-by-case basis. It is in common use for commentary, criticism,
library archiving, news reporting, research, scholarship, and teaching.
If you will be using text or graphics owned by others, you must properly cite the origin of the
information. This should be done whether the copyright symbol or notice is present in the original
or not.
If you suspect a work is copyrighted, seek out the owner and request permission to use all or part of
the work. Many websites have sufficient contact information. If you believe the copyright is
recorded at the U.S. Copyright Office and it was recorded after 1978, you can research the owner
online at www.copyright.gov. Copyrights recorded before 1978 can be researched by their staff for
a fee.

Copyright Notice
The primary way to identify copyrighted material is by checking for a copyright notice. However,
you can no longer depend on this notice being present. The use of a copyright notice was once
required as a condition of copyright protection, but it is now optional. The notice does not register
the copyright with the U.S. Copyright Office. If you wish to register a copyright you must do it
through that office.
It is a good idea to put a copyright notice on your website so visitors are reminded that your site is
protected by copyright. The general form of the notice is “Copyright 2017 The Emerald Epicure
Ltd. All Rights Reserved.” The copyright symbol © may be substituted for the word
“Copyright.”
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Guidelines for Determining and Evaluating Standard Copyright
Rules for Site Content Use
To determine whether or not a content element is valid for reproduction and use, ask yourself the
following questions:
• Did I create it?

• If so, you may use it for whatever you like. You might also want to consider obtaining your
own copyright for the image.

• If not, find out who did and obtain permission. If this is not possible, do not use the image in
question.

• Did I pay for it?
• There are many sites out there on which you can obtain free-to-use graphics and/or

photographs. Some are even free for download. However, if you are using images from one
of these sites, be sure to check the owner's specifications on usage. In some cases they are
free only for personal and not commercial use.

• What am I going to do with it?
• If it is for student use, you are generally free to use it for a project. However, if it is for

commercial purposes, it is vital that you obtain permission from the author so that you don't
end up in court.

• The concept of fair use allows the designer to use the image for educating, research, parodies,
and critiques, as long as its value is not compromised.

• Altering someone else's image does not change ownership, even if it is up to 99 percent
altered. In some cases, courts have found that artwork has not infringed upon copyright laws
because the original image was no longer recognizable. This is not always the case, and is not
a law.

• Where did I get the site content?
• Did you find the content element on the Internet? Some people believe that the Internet is

public domain, but this is not the case.
• If it is an image scanned from print, it is still subject to all copyright laws.

• Is the site content in question?
• If the content is in question, just don't use it.
• It's not worth a lawsuit or the damage it can have on your professional reputation.
• With enough work and training, chances are you can create something similar, eliminating any

concern over violating copyright laws.
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ACTIVITY 8-2
Reviewing Copyright and Citation Principles

Before You Begin
Review the following situations and determine whether or not you should use the site content.

Scenario
Emerald Epicure's marketing department has ideas about a new look for its website. In a meeting,
they showed you mock-ups of web pages that they would like you to develop. You noticed that
some of the content looks like it was downloaded from the Internet. You asked them if they are
aware of copyright restrictions regarding using images. The marketing department manager has
asked you to clarify to the team when it is permissible to use multimedia content.

1. Is it permissible to use a photograph that you took yourself?
A: Yes. These are free to use for whatever you may choose. However, you might want to obtain

permission from any subjects in your photographs before using them publicly or commercially.
Many organizations, including governmental organizations, require that the subjects of photos sign
consent to use forms.

2. Is it permissible to use a logo from another organization?
A: It depends. Logos fall into a kind of a gray area because they are considered creative objects, but

are not always creative enough to warrant copyright protection. Many large corporations have
logo-use standards and specifications on their website, as well as a way to contact someone
concerning its use.

3. Is it permissible to use an image found on the Internet?
A: No. Unless specifically stated, this is not eligible for free use or reproduction.

4. Is it permissible to use a royalty-free image downloaded for free?
A: Yes. However, although the image is royalty-free, meaning the copyright owner does not require

payment or even notification when image is used, it is not necessarily open for use in any
environment. Most images come with specifications for their allotted uses.

5. Is it permissible to use a royalty-free image paid for on a stock photography site?
A: Yes. In most cases, once an image is paid for, you can use it for whatever you may choose.

However, many stock image sites have specific licensing terms that you should become familiar
with before using one of their images.

6. Is it permissible to use a video downloaded from the Internet?
A: Probably not. Most likely, this video is not safe for use. Many free video sites where people upload

their own videos have specific copyright ownership for all videos posted there. As with stock
photography, there are also some free stock video sites available for your use.

146  |  Adobe® Dreamweaver® CC (2017): Part 2

Lesson 8: Setting Project Requirements  |  Topic B

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



TOPIC C
Determine and Evaluate Project Management
Tasks and Responsibilities
As an Adobe Dreamweaver designer and developer, you will need to have a solid understanding of
project tasks and common problems that arise throughout the project development cycle.
In this topic, you will learn how to identify components of a project plan and life cycle, as well as
the importance of receiving feedback on your design plans.

The Project Plan
The objective of a project plan is to identify the approach that the project team will use to produce
and deliver the scope of the project. A well-planned project ensures that the project meets specific
objectives within the given time frame, and helps streamline the development process. At a
minimum, the project plan answers these four questions:
• Why is there a need for the project?
• What is the work that will be performed?
• Who will be involved and what will their responsibilities be?
• When will the project be delivered?
The following table defines some of the items that generally appear within a project plan.

Component Description

Project scope Detail specifications, internal due dates, milestones for project
deliverables that the client would then approve, and final deadlines.

Tasks A list of items that need to be accomplished to meet the project
milestones.

Due dates Due dates include internal deadlines for tasks and project phases, as
well as due dates for client deliverables.

Resource allocation Indicates which tasks go to which team members.

The Project Life Cycle
The project life cycle includes all phases of a project, starting with the idea, progressing through
development, and delivering a finished product or service. It is important to manage a project
throughout the project life cycle to keep the project on track and on budget. Project management
can be broken down into five phases, known as process groups: initiating, planning and analysis,
building, monitoring, and closing.

Initiating
During the initiating phase, the project is sponsored and defined. The deliverable for the initiating
phase is the scope document, which specifies the breadth of the project. It details exactly what will
be delivered, as well as what will not be delivered. For internal projects, it is often written by the
project sponsor, and for external projects, the scope is agreed to by the customer and internal
sponsor. It does not include cost estimates or timelines, as these items are covered separately.

Adobe® Dreamweaver® CC (2017): Part 2  |  147

Lesson 8: Setting Project Requirements  |  Topic C

The Project Plan

The Project Life Cycle

Licensed For Use Only By: Todd  Raines  rainest@ipfw.edu  Jun 16 2021  6:44PM



Planning and Analysis
Good planning in the beginning stages of a project keeps issues down to a minimum, eliminates
rework, and maintains timelines. Planning takes into account all facets of the project. The following
are some things to consider:
• What are your project's objectives? Hold discussions with stakeholders, such as an internal

marketing department, management, or an external client. Agree on the objectives of the project,
for example, providing information, selling to new clients, up-selling current clients, and so on.

• Who is the intended audience? A deliverable designed to appeal to eight-year-old girls will be
different from one designed for neurobiology graduate students. To understand your audience,
analyze the demographics, including age, gender, profession, culture, education, ethnicity,
computer literacy, and so on. Do not assume. Research often reveals surprises. If you have
access to a marketing department, they will often have this information for you.

• What is the output? Deliverables designed for a web server will differ from those intended for
use on an intranet server. Consider things such as resolution, technology, and design. For highly
technical projects, you may need to consult the technology team for specifications.

• What assets are available? Will you be provided assets such as photos, illustrations, and copy or
will you need to acquire or create them yourself?

• What resources can you draw upon? Will you have a team of people? Can you hire contractors
with specific skills, such as photographers, copy writers, and illustrators?

The following documents are created during the planning stage of a project. For smaller projects,
this information may be combined into one document with separate sections.
• The project plan: This document details the specifics of the project, such as project objectives,

audience, deliverables, output, and more.
• Human resource plan: This is an optional document that specifies the people involved, their

roles and responsibilities, dates needed, and resource costing. Detailing this information makes
sure the right person is available at the right stage of the project. One of the biggest mistakes in
project management is overbooking your people, so it is important to be realistic.

• Communication management plan: This is an optional document specifying when certain
communication should occur and methods of communication, as well as any hierarchical
communication chains needed for issue escalation. Dissemination of information throughout the
team is crucial to ensure everyone is on the same page and working together. This can eliminate
duplication of efforts that slow the project or eliminate gaps in the development process that can
bring a project to a standstill. Regular communication with external clients is necessary to keep
them informed of any issues that might affect the delivery of the project in terms of scope,
budget, quality, or completion date.

• Risk management plan: This document identifies any possible stumbling blocks with resources,
time, technology, and so on. Contingency plans are often crafted in advance in case they are
needed. Anticipating problems and being prepared for them keeps the project moving forward.

• Cost management plan: This document breaks the project down in terms of cost. Because no
company has unlimited funds, this document is crucial and usually requires approval from
management.

• Procurement plan: This optional document specifies outside vendors needed to supply assets and
resources. Do you need to hire an outside agency to provide photos, illustrations, or code? If
your deliverable is for an external web site, do you need to secure a hosting partner? You will
probably solicit bids from multiple vendors to get the service at the best price. All this
information can be documented in your procurement plan.

• Schedules and timelines: Knowing when the project is to be completed is obviously important.
However, dividing the project into phases, or even sub-phases, with corresponding due dates will
tell you when the project is going smoothly or when it starts to fall behind, requiring the
implementation of one of your risk management contingency plans.
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Building
During the building phase, the team develops the product or service, using the planning documents
as a guide. The deliverable of the building phase is the project itself, either a product or service.

Monitoring
Monitoring involves overseeing the project to make sure it is delivered on time and on budget with
the expected quality. It is during this phase that modifications to the project scope and planning
documents are made and approved, based on any changes required to the project.

Closing
The closing phase wraps up the project. The product or service is delivered, the contract is closed,
and vendors are paid. External processes or other products are evaluated to see if updates are
required, based on the release of the new product or service.

Feedback on Design Plans
Communication is crucial throughout the project. It is estimated that communicating takes up 90
percent of a project manager's time. A good communicator can really streamline a project.
Verbal communication has the advantage of voice inflections and body language that convey so
much more than words alone can. Through verbal communication, you will know when a team
member is frustrated with an issue, and you can step in to find solutions. Relying on verbal
communication alone, however, can leave you open to miscommunication. Verbal information
might be misunderstood, forgotten, or not heard at all. Written communication used in conjunction
with verbal communication is better if the writing is clear. It gives you a paper trail—something to
refer to when miscommunications arise.
A project that involves visual design can be especially challenging regarding communication, but if
handled well, it can keep the team on track. In the beginning of the design process, usually quick
thumbnails of potential designs are presented to stakeholders and the team. Discussions take place,
and the design is honed down to a few possibilities. More detailed comprehensives (comps) of the
selected designs are created, distributed, and discussed, until one design is agreed upon. There may
then be additional modifications of the chosen design.
During and after each design meeting, it is good practice to record the decisions made. Send an
email with the chosen designs to all team members and stakeholders. Summarize the discussion and
decisions. If anything was heard incorrectly, the participants have a chance to speak up and correct
the miscommunication immediately before unnecessary work begins.
When a design has been selected and honed, create a design document. A design document
communicates the design guidelines to the team members and keeps the design visually unified and
coherent as the project advances. Design documents may include sample layouts, font specifications,
styles, colors, and resolutions. It can be especially important for a deliverable such as a website that
will need maintenance after the project is completed.

Guidelines to Determine and Evaluate Project Management
Tasks and Responsibilities
Here are some guidelines for determining and evaluating project management tasks and
responsibilities:
• Work closely with the client to determine the scope of the project.
• Do not set unrealistic due dates.
• Monitor the timeline and budget to ensure the project stays within estimates.
• Do not over-utilize your resources.
• Leave yourself some buffer time/budget/manpower/other resources.
• Try to stay within the confines of the original scope.
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• Communicate with stakeholders regarding scope creep and other budgetary or timeline issues.
• Regularly involve the client at all phases of the project life cycle.
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ACTIVITY 8-3
Evaluating Project Management

Before You Begin
This is a minds-on exercise in which you will discuss the objectives and tasks of the project
management life cycle. You will provide answers as well as have an open discussion about each
question.

Scenario
Emerald Epicure's marketing department would like to begin a new campaign to launch a new
product. This campaign will include marketing materials such as a new section on their existing
website, new posters, a new logo, and new promotional videos. You will also be working with new
team members as the team leader, a responsibility that is new to you. 

1. What are the five major parts of the project life cycle?
A: Initiation, planning and analysis, building, monitoring, and closing.

2. How will the five life cycle parts apply to this particular project and its objectives?
A: Answers will vary, but you will want to apply the concept of the five life cycle parts to the project in

order to organize the tasks and manage the project effectively.

3. Your team consists of six people, including you. How will you go about dividing up the tasks?
A: Answers will vary. In most cases, you will identify who is best suited for each task, and assign

those people as resources to the tasks accordingly.

4. How will you, as team leader, ensure that you meet the deadline and project objectives?
A: Answers will vary. It is useful to use a project management tool such as a spreadsheet or special

software to help manage your schedule and resources. The project manager must always strive to
make sure everyone is utilized appropriately and has the tools and resources they need to get the
work done.
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Summary
In this lesson, you learned about managing a Dreanweaver project. You learned the components of
the project plan and life cycle and how important it is to involve your client and obtain feedback.

In your own environment, will you be responsible for managing Dreamweaver projects?

A: Answers will vary. If you work for a smaller company or if you are the team lead in a department, the
answer may be yes.

What do you think will be some of the greatest challenges in managing a Dreamweaver project life cycle?

A: Answers will vary. Meeting deadlines while keeping to the original budget will be among the most
challenging tasks. It will also be challenging to keep the client from changing the scope or
requirements during the project.

Note: Check your CHOICE Course screen for opportunities to interact with your classmates,
peers, and the larger CHOICE online community about the topics covered in this course or
other topics you are interested in. From the Course screen you can also access available
resources for a more continuous learning experience.
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Course Follow-Up
Congratulations! You have completed the Adobe® Dreamweaver® CC (2017): Part 2 course. You have
successfully created an engaging, responsive website using Bootstrap. Your site includes text, forms,
graphics, movement, and videos to convey key points of your message. You have explored social
media campaigns and produced an HTML email message. With millions of websites competing for
users' attention, your ability to create a website that meets its intended purpose, objectives, and
expectations of your target audience will define its success or failure. With Dreamweaver, you can
efficiently create appealing websites that are compatible for a wide range of target audiences.

What's Next?
This is the last course in the Adobe® Dreamweaver® CC series, although you are encouraged to
explore the other courses in the Logical Operations series of Adobe CC courseware. You may also
explore Dreamweaver further by actively participating in any of the social media forums set up by
your instructor or training administrator through the Social Media tile on the CHOICE Course
screen.
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Mastery Builders

Mastery Builders are provided for certain lessons as additional learning resources for this
course. Mastery Builders are developed for selected lessons within a course in cases when
they seem most instructionally useful as well as technically feasible. In general, Mastery
Builders are supplemental, optional unguided practice and may or may not be performed as
part of the classroom activities. Your instructor will consider setup requirements, classroom
timing, and instructional needs to determine which Mastery Builders are appropriate for you
to perform, and at what point during the class. If you do not perform the Mastery Builders
in class, your instructor can tell you if you can perform them independently as self-study,
and if there are any special setup requirements.
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Mastery Builder 2-1
Writing for Mobile Platforms

Activity Time: 20 minutes

Data Files
All files in C:\092006Data\Writing_for_Mobile_Platforms\lab\starter

Scenario
You are creating a website for Greene City BBQ Kitchen, which offers catering and
take-out. To ensure that your website is displayed properly in any given device, you
decide to use Bootstrap to lay out the home page. Your mock-up of the home page
layout looks like this:
 

 

1. Create a site in Dreamweaver pointing to the folder C:\092006Data
\Writing_for_Mobile_Platforms\lab\starter.

2. Create a blank page by using Bootstrap. Do not use the built-in layout.

3. Save the page as index.html

4. By using the aforementioned wireframe, lay out the page. Use Bootstrap components.
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5. Change the container div tags to semantic html5 tags as in the aforementioned wireframe.

Note: Use Split view.

6. Replace the image placeholder with the image GCBBQKHomeGraphic.jpg.

7. In the css folder, create a CSS page and name it style.css
This will be used in a subsequent lab.

8. Attach style.css to index.html.

9. Save and preview the file. Your result should look like this:
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Mastery Builder 3-1
Creating Forms

Activity Time: 10 minutes

Data Files
All files in C:\092006Data\Creating_Forms\lab\starter

Scenario
You want feedback from customers who have used your catering service or ordered
takeout. You decide to create a form to obtain feedback.

1. Create a Bootstrap page.

2. Save the page as survey.html

3. Attach the page to the existing style.css page.

4. Insert a form with the ID survey.

5. Set the form action to survey.asp

6. Insert text form elements with the ID and labels First Name and Last Name

7. Use check boxes to ask whether the customer purchased catering or take-out.

8. Use radio buttons to ask if the customer was Very Satisfied, Satisfied, Dissatisfied, or
Very Dissatisfied.

9. Use a text area to request comments.

10. Add Submit and Refresh buttons.

11. Save your changes and preview in browser.
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Mastery Builder 4-1
Creating Movement

Activity Time: 10 minutes

Data Files
All files in C:\092006Data\Creating_Movement\lab\starter

Scenario
You decide to add movement to the home page in order to enhance visitor interest.

1. Use Manage Sites to switch to C:\092006Data\Creating_Movement\lab\starter.

2. Open index.html.

3. In the left column, select the image catering_page.jpg and observe that it has been assigned the ID
Beef.

4. Add a behavior so that the image changes to catering2.jpg on hover.

Note: Work in Design view and use swap image.

5. In the second column, add a Heading 3:H3 with the text "The best catering in town”

6. Save your changes and preview the movement in a browser.
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Mastery Builder 5-1
Adding Multimedia

Activity Time: 10 minutes

Data Files
All files in C:\092006Data\Adding_Multimedia\lab\starter

Scenario
You decide to add music to the home page.

1. Use the files in C:\092006Data\Adding_Multimedia\lab\starter.

2. Open index.html.

3. Select the heading “The best catering in town.”

4. Insert an HTML5 Audio tag after the heading.

5. Set the source to EE_audio.mp3.

6. Set the audio file to Autoplay and Loop.

7. If time allows, use CSS to set the maxwidth to 300px.

8. Save your changes and preview the file in browser.
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Mastery Builder 6-1
Marketing Through Social Media and Email

Activity Time: 20 minutes

Data Files
All files in C:\092006Data\Marketing_Through_Social_ Media_and_Email\lab\starter

Scenario
Your marketing department is planning a big push to increase takeout orders. You are tasked with
designing an HTML email message to send to everyone on the customer email list.

1. Use the files in C:\092006Data\Marketing_Through_Social_ Media_and_Email\lab\starter.

2. Create an HTML email message by using the Starter Template: Email Templates: Email - Responsive.

3. Save the file as takeout_email.html

4. Use GCBBQKHomeGraphic_small.jpg to replace the 576 × 250 image placeholder.

5. Replace the text “Email theme” with Takeout you’ll talk about

6. Add the images catering_page_small.jpg and catering2_small.jpg to the first two small image
placeholders. Add descriptive text as you wish.

7. Save your changes and preview it in the browser.

8. As time allows:
a) Add links to the home page.
b) Delete the row containing the large block of placeholder text.
c) Delete the second row of small images/text/links.
d) Save your changes and preview it in the browser.
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Solutions

ACTIVITY 1-1: Examining Website Design Considerations

1. Which of the following are design considerations that you will need to think about before
starting your website design? (Choose two.)
☑  Target audience
☑  Purpose of a website
☐  Software application
☐  Web page navigation

2. Which of the following audience characteristics should you evaluate while designing a website?
(Choose four.)
☑  Age
☐  Ethnicity
☑  Educational qualification
☑  Income
☑  Level of computer literacy
☐  Marital status

3. Observe the screen capture of a web page. What design flaws do you see?
A: Discuss the following possible answers: There are too many fonts. The font used for the
sentence "If green olives are required they are harvested earlier" is difficult to read. There is
insufficient contrast between the font color and the background color. Students might also note
that the image of the harvest tool has padding, while the image of the olives does not, and that
the arrangement and spacing of the text and two pictures is unattractive.

4. Sylvia has been assigned the task of developing a website for a client, Emerald Epicure, within
a week. Because the client wants the site to be up and running soon, Sylvia immediately
begins designing the site and soon proceeds to developing the layout and then the coding for
the site. In your opinion, is Sylvia’s decision to immediately get started with designing the
website appropriate?
A: Answers may vary, but can include: Skipping tasks such as identifying the website purpose
and analyzing the target audience may result in developing a website that fails to meet its
intended purpose. This can result in rework and delays in meeting scheduled commitments.
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ACTIVITY 1-2: Designing Usable and Accessible Sites

1. Observe the following draft home page and suggest modifications to enhance usability.
A: Answers will vary and may include: Enlarge the text, add white space, break up the
text with headers, add bulleted lists, and format keywords as bold or italic.

2. Re-examine the image above and suggest ways to enhance accessibility.
A: Answers will vary and might overlap with answers in the previous question. Answers
might include: The table header row should be highlighted and font size should be larger.

3. Examine the following code for the images of olives and urns in the screen shot above.
How could the code be modified to enhance accessibility?
A: Images should have descriptive alt text.

ACTIVITY 2-3: Adding Styles to a Media Query

1. With index.html open, in the Visual Media Query bar, select the green bar for the media
query with a width of 768px. Observe changes in the page appearance. What would you
want to change in this view?
A: Answers may vary. The Contact us navigation button overlaps the Harvesting button.

ACTIVITY 3-1: Creating a Form

4. Which form property is used to define the procedure by which a form's data is submitted
to a server?
○  Form ID
○  Class
○  Method
◉  Action

5. What are some of the most common uses of forms?
A: Answers will vary, but may include: to collect information and feedback from site
visitors, conduct surveys, perform business transactions, and provide login or search
mechanisms.

ACTIVITY 6-1: Planning a Social Media Strategy

1. Who should be on the social media planning team and why?
A: Possible answers include a representative from the organization’s strategic planning
team, a representative from marketing and sales teams, a representative from customer
service, the web designer, and the graphic artist.
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2. Is there any additional information you need on your target audience?
A: Answers may vary, but may include age demographics, what proportion of buyers live in rural versus
urban areas, and more information on the small restaurants. The company might research behaviors,
lifestyles, and personality factors of current customers or desired customers. The company might plan
to target new market segments.

3. Visit one or more of the sites offering information on which demographics use which social media
platforms. Which platforms most closely match your target audience’s demographics?
A: Answers may vary. The Pew report in particular offers a wealth of information. Ragan offers a
condensed, easy-to-read version of the report, plus additional related articles. As of this manual's
publication date, the latest Pew repost lists Facebook as the most widely used platform and Instagram
as the second-largest population of women using a social network.

4. One of Emerald Epicure’s social media goals is to promote new products, specifically French olives
such as Niçoise and Picholine. List several options for keywords.
A: Answers may vary, but may include imported French olives, Niçoise olives, Picholine olives, imported
French Niçoise olives. Long-tail keywords have both advantages and disadvantages. Further research
may be advisable.

5. Your colleague develops the following graphic to use on social media. The olives are green and the
words Emerald Epicure match the green shade of the olives, a different shade than your logo. How
effective do you think it might be? How would it fit into your marketing plan?
A: Answers will vary. The image does not use the colors of the website, and the company name is
rendered in a different font than in the website. The image does not include the logo. Therefore, either
the website or the image is not consistent with the company’s branding. Persons who have visited the
website and later see this graphic might wonder if the graphic is from a different company of the same
name.

6. If you decide to use the image, what revisions might you make to the ad?
A: Answers will vary. The company might consider adding the Emerald Epicure logo, rendering the
company name and perhaps the tag line in the brand color and font, or other changes to make the ad
more consistent with Emerald Epicure branding.

7. If you do post the ad, what platform would you use?
A: Answers will vary. A simple image of this type, with revisions, might be used as an ad on Facebook
or Pinterest. Other platforms may also be suitable.

ACTIVITY 7-1: Validating Your Site Against W3C Standards

3. What are some of the details listed in a storyboard? (Choose four.)
☑  Assets used on the site
☑  Navigation structure
☑  User interaction components
☑  Site validation requirements
☐  Project plan
☐  Coding standards
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4. Which test will you perform on the site to ensure that all the objectives that the site was
built to meet are achieved?
○  W3C validation
○  Usability
◉  Storyboard
○  Site report

5. True or False? The participants in the usability test are members of the team that
developed the site.
☐  True
☑  False

ACTIVITY 8-1: Determining Your Target Audience

1. What is the target audience demographic, such as age, gender, profession, and so on?
A: Answers will vary. Some will say that the adult professional woman is the target.
Others might expand the gender to both sexes, or place the age at mid-30s–50s.

2. In what type of environment would the product be most successful?
A: Answers will vary. Some will suggest that an upscale boutique shop would be an
excellent venue. Others might say online or in a coffee shop.

3. Is the finished design effective in reaching its target audience?
A: Answers will vary, but the consensus will probably be yes.

4. What is the target audience?
A: Answers will vary. Some will say women of all demographic types and ages. Others
will say it also includes men. Still others will say anyone who is concerned with finding a
cure for breast cancer.

5. What is the objective of the website?
A: Answers will vary. Some will point to the fund-raising aspect. Others will highlight the
informational aspect or the effort at building a community.

6. What is the target audience?
A: Answers will vary. Some will say the parents of kids. Others will say the kids
themselves.

7. Which elements present in the design lead you to that conclusion?
A: Answers will vary. Those who say the target is parents will point out that the phone
number and web address point to an older audience. Others will say the headline of
feeding a giraffe would be especially exciting to children.

8. What is the target audience?
A: Answers will vary. Most will say women in their 20s and 30s.

9. Given the client, is this an effective way to advertise their product?
A: Answers will vary. Some students may remember seeing advertising by GAP NOW.
People will have different opinions about the effectiveness of this approach. Some will
say that it suggests that the target audience wants to differentiate themselves from past
generations and, therefore, the approach is effective.
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10. Is it evident that this is an attempt at reaching a new demographic?
A: Answers will vary. Some will point out that the color and makeup of the subjects on the left make the
images look older, more artificial, and dated (That was then...). The "This is now." images are brighter in
color, more vibrant, closer, and more intimate. Some will say it is a new demographic (generation).
Others will say it's the same demographic that is re-inventing itself culturally.

11. What is the target audience?
A: Answers will vary, but many will say a slightly younger crowd looking for "edgier" tattoo designs.

12. Which elements present in the design lead you to that conclusion?
A: Answers will vary. The designs are atypical, with more unusual colors. The background is black,
which suggests a younger crowd.

13. What about this particular design makes it somewhat different from the previous designs?
A: Answers will vary. The images are "darker" in emotional tone and more fanciful and fantasy-oriented.

ACTIVITY 8-2: Reviewing Copyright and Citation Principles

1. Is it permissible to use a photograph that you took yourself?
A: Yes. These are free to use for whatever you may choose. However, you might want to obtain
permission from any subjects in your photographs before using them publicly or commercially. Many
organizations, including governmental organizations, require that the subjects of photos sign consent to
use forms.

2. Is it permissible to use a logo from another organization?
A: It depends. Logos fall into a kind of a gray area because they are considered creative objects, but
are not always creative enough to warrant copyright protection. Many large corporations have logo-use
standards and specifications on their website, as well as a way to contact someone concerning its use.

3. Is it permissible to use an image found on the Internet?
A: No. Unless specifically stated, this is not eligible for free use or reproduction.

4. Is it permissible to use a royalty-free image downloaded for free?
A: Yes. However, although the image is royalty-free, meaning the copyright owner does not require
payment or even notification when image is used, it is not necessarily open for use in any environment.
Most images come with specifications for their allotted uses.

5. Is it permissible to use a royalty-free image paid for on a stock photography site?
A: Yes. In most cases, once an image is paid for, you can use it for whatever you may choose.
However, many stock image sites have specific licensing terms that you should become familiar with
before using one of their images.

6. Is it permissible to use a video downloaded from the Internet?
A: Probably not. Most likely, this video is not safe for use. Many free video sites where people upload
their own videos have specific copyright ownership for all videos posted there. As with stock
photography, there are also some free stock video sites available for your use.

ACTIVITY 8-3: Evaluating Project Management

1. What are the five major parts of the project life cycle?
A: Initiation, planning and analysis, building, monitoring, and closing.
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2. How will the five life cycle parts apply to this particular project and its objectives?
A: Answers will vary, but you will want to apply the concept of the five life cycle parts to
the project in order to organize the tasks and manage the project effectively.

3. Your team consists of six people, including you. How will you go about dividing up the
tasks?
A: Answers will vary. In most cases, you will identify who is best suited for each task, and
assign those people as resources to the tasks accordingly.

4. How will you, as team leader, ensure that you meet the deadline and project objectives?
A: Answers will vary. It is useful to use a project management tool such as a spreadsheet
or special software to help manage your schedule and resources. The project manager
must always strive to make sure everyone is utilized appropriately and has the tools and
resources they need to get the work done.
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Glossary

Bootstrap
A popular framework for writing
responsive pages in an efficient manner. It
uses HTML5 and CSS templates and
JavaScript plug-ins to provide a responsive
grid layout, plus responsive navigation,
text, buttons, forms, tables, images, image
carousels, and more.

check-in feature
In Dreamweaver, the process of placing a
checked-out file back onto the server.

check-out feature
In Dreamweaver, the process of taking out
a file from the server for editing. While a
file is checked out by one author, other
authors cannot edit it.

copyright
The protection of a specific and tangible
expression of an idea.

fluid layout
A layout in which the width of page
elements is defined as a percentage of their
containers; with a fluid layout, as the
viewport size changes, the element's size
changes proportionally. Fluid layouts may
also be referred to as liquid layouts.
Although a liquid layout is often used in
responsive design, you will still need to use
media queries to make further adjustments
in page appearance for varied viewports.

form
An HTML element that allows for data
collection and data submission to a server.

form element
Enables users to enter their data directly in
a form and record the inputs.

form property
The features of a form that determine what
happens to the form when it is submitted.

form validation
The task of verifying if the data entered in
a form is valid, meaning that it meets
criteria that you set.

grid layouts
A design approach in which the page is
divided into columns. A grid layout can be
used in designing a web page or other
artwork.

intellectual property
All products resulting from human
creativity.

keywords
Search words or phrases potential site
visitors type into search engines.

KPI
(key performance indicator) A metric that
is measurable and can be used to gauge
whether or not activities are progressing
toward a defined goal. For example, if the
goal is to post 30 blog posts a month, the
KPI might be one blog post per day.

long-tail keywords
Keyword phrases that are made up of
more than one word.
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media query
Code that applies a block of CSS
properties only when a page is viewed on
devices with certain capabilities, such as a
specified width, orientation, or resolution.
It can also be used to apply CSS properties
only when the page is printed.

project life cycle
All phases of a project, starting with the
idea, progressing through development,
and delivering a finished product or
service.

responsive web design
Designing a web page for use on various
devices. You can use HTML, CSS, and
perhaps scripts to resize, move, hide,
shrink, enlarge, or otherwise change the
appearance of the content for optimal
viewing on smartphones, tablets, laptops,
and desktops with a range of viewport
sizes.

SSL
(Secure Socket Layer) A protocol used to
provide extra security when
communicating across multiple networks.

synchronization
A feature in Dreamweaver that allows you
to compare the local version of your
website with the remote version.

usability
The extent to which users can find and
absorb relevant content, access the site’s
functions, and feel satisfied with the
process of doing so.

usability testing
A process to ascertain how easily and
effectively visitors can use a website.

Validate Form behavior
A process of validating whether or not the
values in specific text fields are numeric
and if numeric, whether they fall within a
range of values.

viewport
The area of a web page visible to the user;
the size of the viewport is of critical

importance when designing responsive
pages. The viewport is not necessarily the
total width of the device, but rather the
area in which the page is rendered.
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A
accessibility 8
audience 2
audio

element 84
types of 84

B
behaviors 76–78
Bootstrap 28, 29, 31, 34, 36, 47, 48
branding 93
broken link checker 116
building phase 149

C
Cascading Style Sheets, See CSS
check-in feature 123
checking broken links 116
check-out feature 122
client feedback 149
cloaking 124
closing phase 149
color 3
consistency 3
copyright

and fair use 144
and permissions 144
defined 144
notice 144

CSS
descendant selectors 48
Designer panel 19, 24
Transitions 70

D
dependent files 123
descendant selectors 48
design

accessibility 8
behaviors 76
consistency 3
mobile 12
movement 70
responsive 13, 28
transitions 70
usability 7
writing for mobile devices 12

E
Element Display 37
email marketing 101–103
Extensible Markup Language, See XML

F
Facebook 93, 97
fair use 144
feedback from client 149
file comparison 133
fluid grid layouts 28
fluid layouts 28
fonts 3
form

defined 54
element 55
element types 55
processing methods 55
properties 54
validation 62, 63
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G
Get action 55
grid layouts 28

H
HTML5 84, 87
HTTPS 121

I
initiating phase 147
intellectual property 144

K
key performance indicator, See KPI
keywords

defined 94
long-tail 94

KPI 92

L
Live view 36, 38
long-tail keywords 94

M
markup validation 116
media query 19
mobile

design 12
writing challenges 12

monitoring phase 149
movement benefits 70
multimedia 84

N
navigation 7

P
permissions 144
planning and analysis phase 148
platforms for social media 92, 93
Post action 55
project life cycle 147
project planning 147
project requirements

audience 138
audience needs 138

purpose 138

R
responsive web design 13

S
scope document 147
Secure Socket Layer, See SSL
social media

defined 92
platforms 92, 93
strategy 92

SSL 121
storyboard testing 116
synchronization

defined 132
direction 132

T
target audience 2
transitions 70
Twitter 93, 97

U
usability

defined 7
testing 117

usability testing 116

V
Validate Form behavior 63
validating markup 116
validation techniques 116
video

tag 87
types of 87

viewport 13, 24
Visual Media Query bar 12, 19

W
W3C 116
website design 2, 3
World Wide Web Consortium, See W3C
writing for mobile devices 12

X
XML 3
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